Note • Before using this information and the product it supports, read the information in Appendix B, Notices.
# Table of Contents

## Preface
- Who Should Read This Guide ......................................................... ix
- What This Guide Contains ......................................................... ix
- Related Publications ..................................................................... x
- Contacting Customer Support ....................................................... xi
- Conventions Used in This Guide ................................................... xi
- Terminology: Reports, Graphs, and Spreadsheets ............................. xii

## 1 • Getting Started
- About ITUAM Web Reporting ....................................................... 1-2
- Types of ITUAM Web Reporting Users ......................................... 1-2
- Starting ITUAM Web Reporting ..................................................... 1-2
- Logging On To ITUAM Web Reporting ......................................... 1-3
- Using the Menu Bar ..................................................................... 1-5
- Changing Your Password ............................................................. 1-5
- Logging Off ................................................................................. 1-6
- Viewing Online Help ................................................................... 1-6
- Timing Out .................................................................................. 1-6
- Assigning Folder Security Permissions ........................................ 1-7
# Table of Contents

## 2 • Running Reports

- Introduction to Report Types ................................................................. 2-2
- Running Reports ....................................................................................... 2-3
  - Using Report Parameters ................................................................. 2-4
  - About Account Codes ....................................................................... 2-7
  - Example: Running a Report .............................................................. 2-8
- Creating and Running Web User Created Reports .............................. 2-9
  - Creating or Updating a Web User Created Report ......................... 2-9
  - Running a Web User Created Report .............................................. 2-10
  - Deleting a Web User Created Report ............................................ 2-10
  - Example: Creating and Running a Web User Created Report .......... 2-11
- Creating and Viewing Published Reports ........................................... 2-12
  - Publishing Reports ........................................................................... 2-12
  - Viewing Published Reports ............................................................... 2-14
  - Example: Creating and Viewing a Published Report ..................... 2-16
  - Deleting Published Reports ............................................................... 2-17

## 3 • Working With Reports

- Working With Reports ............................................................................ 3-2
  - About the Report Interface ............................................................... 3-2
  - Using the Reporting Toolbar ............................................................. 3-3
  - Navigating Using the Group Tree ...................................................... 3-4
  - Drilling Down in Reports ................................................................. 3-4
  - Publishing Reports ............................................................................ 3-8
  - Saving Reports .................................................................................... 3-8
  - Copying Text From a Report ............................................................. 3-8
- Working With Spreadsheets ................................................................. 3-9
  - About the Spreadsheet Interface ....................................................... 3-9
  - Publishing Spreadsheets ................................................................ 3-9
  - Opening a Spreadsheet in Excel ...................................................... 3-10
  - Working With Spreadsheets in Excel ............................................... 3-10
4 • Administering ITUAM Web Reporting

Configuring User-Specific Settings ......................................................... 4-2
Working With Favorite Reports ......................................................... 4-2
Showing or Hiding Folder Paths for Published Reports ......................... 4-5
Selecting an Account Code Structure for Reports ................................. 4-5
Choosing a Crystal Report Viewer ..................................................... 4-6
Changing Your E-mail Address .......................................................... 4-7
Resetting the Browser ..................................................................... 4-7

Configuring System-Wide Settings ..................................................... 4-8

Accessing ITUAM Financial Modeler and ITUAM Web Console ........... 4-11

5 • Using Transactions

Working With Transactions ............................................................... 5-2
Adding Transactions ........................................................................ 5-3
Editing Transactions ....................................................................... 5-4
Deleting Transactions ..................................................................... 5-4
Navigating Transactions .................................................................. 5-4

6 • Troubleshooting

General Problems ............................................................................. 6-2
Computer locks up or runs slowly .................................................. 6-2

Connection Problems ...................................................................... 6-2
Unable to connect to the ITUAM Web Reporting Web site ................. 6-2

Web Reporting Problems ................................................................. 6-3
Problems accessing the Web site or generating reports ...................... 6-3
Reports are missing from reports lists ............................................. 6-10
Reports take a long time to generate .............................................. 6-10
Web reporting session is timing out before or after session timeout value .. 6-10
An error message appears when ActiveX Data Objects (ADO) or ODBC is used to open a database connection in an ASP page ......................................................... 6-10
Published reports do not appear on the Published Reports page ........... 6-11

Crystal XI Problems .......................................................................... 6-12

SQL Server Reporting Services Problems ....................................... 6-13
Report Server cannot decrypt the symmetric key message appears ........ 6-13
The user account does not have adequate permissions message appears when you try to generate a report .......................................................... 6-13
# Table of Contents

## A  Standard Reports

- About ITUAM Reports ......................................................... A-4
- Location of ITUAM Reports ............................................. A-4
- Report Naming Conventions ............................................. A-5
- Conventions Used in This Appendix ................................. A-5
- Reports by File Name ....................................................... A-6
- Graphs ................................................................................. A-8
  - Cost Trend—Accounts Graph ........................................ A-8
  - Cost Trend—Rates Graph ............................................. A-9
  - Resource Trend Graph ................................................ A-10
- Drill Down Reports ............................................................ A-11
  - Invoice Drill Down for Rate Group Report ......................... A-11
  - Invoice Drill Down for Rate Group by Date Report ............. A-13
  - Invoice Drill Down for Units Report ............................... A-14
- Reports ................................................................................. A-16
  - Client Audit Report ......................................................... A-16
  - Rate Audit Report ........................................................ A-18
  - Transaction Audit Report ............................................ A-20
  - Batch Report .............................................................. A-22
  - Account Budget for Period and YTD Report .................. A-23
  - Line Item Budget for Period and YTD Report ................. A-24
  - Configuration Report .................................................... A-25
  - CICS Transaction Report ............................................... A-26
  - Client Report ............................................................. A-27
  - Account Summary Daily Report ........................................ A-28
  - Account Summary Daily 2 Report ..................................... A-29
  - DB2 Summary Report ................................................... A-30
  - Detail by Rate Group Report ............................................ A-31
  - Detail by Rate Group/Identifier Report ............................... A-32
  - Detail Rate Codes by Identifiers ........................................ A-33
  - Detail Rate Codes by Identifiers/Account .......................... A-34
  - Invoice by Account Level V2 Report ............................... A-36
  - Alternate Invoice Report ................................................. A-36
  - Account Total Invoice Report ........................................... A-38
  - Invoice with Budget Report ............................................. A-39
  - Invoice Report ............................................................... A-41
  - Invoice by Account Level Report ....................................... A-43
  - Invoice with Shifts Report ............................................... A-45
  - Run Total Invoice Report ................................................ A-47
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Total Percent Report</td>
<td>A-48</td>
</tr>
<tr>
<td>Run Total Rate Group Percent Report</td>
<td>A-49</td>
</tr>
<tr>
<td>Run Total Invoice with Shifts</td>
<td>A-50</td>
</tr>
<tr>
<td>Zero Cost Center Invoice Report</td>
<td>A-51</td>
</tr>
<tr>
<td>Zero Cost Center Factor Report</td>
<td>A-53</td>
</tr>
<tr>
<td>Job Cost Report</td>
<td>A-54</td>
</tr>
<tr>
<td>MS SQL Server 2000 Resource Report</td>
<td>A-56</td>
</tr>
<tr>
<td>Percentage Report</td>
<td>A-57</td>
</tr>
<tr>
<td>Rate Report</td>
<td>A-58</td>
</tr>
<tr>
<td>Top Cost Report</td>
<td>A-59</td>
</tr>
<tr>
<td>Top 10 Bar Graph Report</td>
<td>A-61</td>
</tr>
<tr>
<td>Top 10 Pie Chart Report</td>
<td>A-63</td>
</tr>
<tr>
<td>Top Accounts for Rate Report</td>
<td>A-65</td>
</tr>
<tr>
<td>Cost Trend Report</td>
<td>A-66</td>
</tr>
<tr>
<td>Cost Trend by Rate Report</td>
<td>A-67</td>
</tr>
<tr>
<td>Resource Usage Trend Report</td>
<td>A-68</td>
</tr>
<tr>
<td>Transaction Report</td>
<td>A-69</td>
</tr>
<tr>
<td>Cost Variance Report</td>
<td>A-70</td>
</tr>
<tr>
<td>Cost Variance Drill Down Report</td>
<td>A-71</td>
</tr>
<tr>
<td>Resource Variance Report</td>
<td>A-72</td>
</tr>
<tr>
<td>Disk Directory Resource Report</td>
<td>A-73</td>
</tr>
<tr>
<td>Account Summary by Week Report</td>
<td>A-74</td>
</tr>
<tr>
<td>Account Summary by Week—Wide Report</td>
<td>A-75</td>
</tr>
<tr>
<td>Account Summary YTD Report</td>
<td>A-76</td>
</tr>
<tr>
<td>Account Summary YTD—Wide Report</td>
<td>A-77</td>
</tr>
<tr>
<td>Spreadsheets</td>
<td>A-78</td>
</tr>
<tr>
<td>Invoice Spreadsheet</td>
<td>A-78</td>
</tr>
<tr>
<td>Run Total Invoice Spreadsheet</td>
<td>A-79</td>
</tr>
<tr>
<td>Invoice by Rate Group Spreadsheet</td>
<td>A-80</td>
</tr>
<tr>
<td>Invoice by Account Code Spreadsheet</td>
<td>A-81</td>
</tr>
<tr>
<td>Proration by Total Amount Spreadsheet</td>
<td>A-82</td>
</tr>
<tr>
<td>Proration by Rate Code Spreadsheet</td>
<td>A-83</td>
</tr>
<tr>
<td>Proration by Rate Group Spreadsheet</td>
<td>A-84</td>
</tr>
<tr>
<td>Top 10 Accounts for Rate Spreadsheet</td>
<td>A-85</td>
</tr>
<tr>
<td>Account Summary Week Spreadsheet</td>
<td>A-86</td>
</tr>
<tr>
<td>Account Summary YTD Spreadsheet</td>
<td>A-87</td>
</tr>
<tr>
<td>Account Summary YTD by Rate Spreadsheet</td>
<td>A-88</td>
</tr>
<tr>
<td>Account Summary YTD Cost by Rate Group Spreadsheet</td>
<td>A-89</td>
</tr>
</tbody>
</table>
Table of Contents

Crosstab Reports ................................................................. A-90
  Daily Crosstab—Charges .................................................. A-90
  Daily Crosstab—Usage ..................................................... A-91
  Detail by Identifier Crosstab .............................................. A-92
  Detail by Identifier by Date Crosstab ................................. A-93
  Monthly Crosstab—Charges ............................................... A-94
  Monthly Crosstab—Usage .................................................. A-95
  Summary Crosstab—Charges ............................................... A-96
  Summary by Rate Group Crosstab—Charges ......................... A-97
  Summary Crosstab—Usage .................................................. A-98
  Summary by Rate Group Crosstab—Usage ............................ A-99
  Weekly Crosstab—Charges ............................................... A-100
  Weekly Crosstab—Usage .................................................. A-101

Templates ................................................................. A-102
  Report Both Template ..................................................... A-102
  Report Cost Template .................................................... A-104
  Report Resource Template ............................................... A-105
  Spreadsheet Both Template ............................................. A-105
  Spreadsheets Cost Template .......................................... A-107
  Spreadsheets Resource Template ...................................... A-108

B Notices

Trademarks ................................................................. B-3

Glossary

Index
Preface

This guide explains how to administer and use IBM® Tivoli® Web Reporting. Note that some features described in this guide might have been customized for your organization. In this case, consult your IBM Tivoli Usage and Accounting Manager administrator for assistance.

For the purposes of world-wide marketing, IBM Tivoli Usage and Accounting Manager is sometimes referred to as IBM Usage and Accounting Manager or ITUAM. Users of this product may see these names in presentations and product collateral. For the purposes of this guide, the product is referred to as ITUAM unless referring to another document or entity that contains the full name.

Who Should Read This Guide

This guide is for system administrators and end users responsible for administering and using ITUAM Web Reporting.

ITUAM Web Reporting is a component of ITUAM. This guide assumes that the ITUAM system is installed and configured as described in the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.

What This Guide Contains

The following table describes the chapters in this guide.

<table>
<thead>
<tr>
<th>Ch. No.</th>
<th>Chapter Name</th>
<th>Content Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Getting Started</td>
<td>Introduces the ITUAM Web Reporting interface and provides steps for logging in and out and other tasks.</td>
</tr>
<tr>
<td>2</td>
<td>Running Reports</td>
<td>Introduces the different report types and describes how to run these reports.</td>
</tr>
<tr>
<td>3</td>
<td>Working With Reports</td>
<td>Describes how navigate and use generated reports.</td>
</tr>
</tbody>
</table>
As you use this guide, you might find it helpful to have the IBM Tivoli Usage and Accounting Manager Administrator’s Guide available for reference.
Contacting Customer Support

Before contacting IBM Tivoli Software Support with a problem, refer to the IBM Tivoli Software Support site by clicking the Tivoli link at the following Web site:

http://www.ibm.com/software/support/

If you need additional help, contact software support by using the methods described in the IBM Software Support Guide at the following Web site:

http://techsupport.services.ibm.com/guides/handbook.html

The IBM Software Support Guide provides the following information:

- Registration and eligibility requirements for receiving support.
- Telephone numbers, depending on the country in which you are located.

A list of information you should gather before contacting technical support.

Conventions Used in This Guide

Some or all of the following conventions appear in this guide:

<table>
<thead>
<tr>
<th>Symbol or Type Style</th>
<th>Represents</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alternate color</strong></td>
<td>hyperlinked cross-references to other sections in this guide; if you are viewing this guide online, you can click the cross-reference to jump directly to its location</td>
<td>......see Related Publications.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>words that are emphasized</td>
<td>...the entry after the current entry...</td>
</tr>
<tr>
<td></td>
<td>a new term</td>
<td>...by identifier values.</td>
</tr>
<tr>
<td></td>
<td>the titles of other manuals</td>
<td>IBM Tivoli Usage and Accounting Manager Administrator’s Guide</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>names of interface items such as tabs, boxes, buttons, lists, and check boxes.</td>
<td>The Reports menu</td>
</tr>
<tr>
<td></td>
<td>Select the Change Password check box</td>
<td>The Group Tree appears in the Preview tab</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>directories, file names, command names, computer code, computer screen text, system responses, command line commands, what the user types</td>
<td>Server folder</td>
</tr>
<tr>
<td></td>
<td>ProcTransactions.wsf script</td>
<td>Type iisreset /restart</td>
</tr>
</tbody>
</table>
## Terminology: Reports, Graphs, and Spreadsheets

For simplicity, in this guide, the term “report” refers to reports, graphs, and spreadsheets unless noted otherwise.

<table>
<thead>
<tr>
<th>Symbol or Type Style</th>
<th>Represents</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; &gt;</td>
<td>the name of a key on the keyboard</td>
<td>Press &lt;Enter&gt;</td>
</tr>
<tr>
<td>▶</td>
<td>navigating a menu or a folder</td>
<td>Reports▶View Published Reports</td>
</tr>
</tbody>
</table>
Getting Started

This chapter describes how to get started using ITUAM Web Reporting. ITUAM Web Reporting is accessible via your Web browser (see Starting ITUAM Web Reporting on page 1-2).

About ITUAM Web Reporting ......................................................... 1-2
Types of ITUAM Web Reporting Users ........................................... 1-2
Starting ITUAM Web Reporting ..................................................... 1-2
Logging On To ITUAM Web Reporting .......................................... 1-3
Using the Menu Bar ........................................................................... 1-5
Changing Your Password ................................................................. 1-5
Logging Off ..................................................................................... 1-6
Viewing Online Help ....................................................................... 1-6
Timing Out ...................................................................................... 1-6
Assigning Folder Security Permissions ........................................... 1-7
About ITUAM Web Reporting

ITUAM Web Reporting enables you to generate and view IT chargeback and resource accounting reports from a Web browser. These reports include invoice, budget, summary, trend, and variance reports in report, graph, and spreadsheet format.

You can save, copy text from, and print reports. In addition, many reports generated using ITUAM Web Reporting include multi-level drill down capabilities that enable you to view detailed resource usage and cost information.

ITUAM Web Reporting supports reports written in any of the following:

- SQL Server Reporting Services
- Crystal Reports

Types of ITUAM Web Reporting Users

There are two types of ITUAM Web Reporting users:

- **Administrators.** Administrators can perform administrative functions in ITUAM Web Reporting such as changing the configuration options for the application (see Configuring System-Wide Settings on page 4-8). Administrative access is assigned by your ITUAM administrator. For more information, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.

- **End Users.** End users have no administrative privileges.

The terms ITUAM Web administrator and ITUAM Web end user are used in this guide to differentiate the two user types when needed.

Starting ITUAM Web Reporting

To start ITUAM Web Reporting, open your Web browser and enter the URL for ITUAM Web Reporting in the Address bar. The specific URL depends on your organization—see your system administrator for the URL.
Logging On To ITUAM Web Reporting

There are two methods for logging on to ITUAM Web Reporting:

■ **Auto logon.** Auto logon enables you to use ITUAM Web Reporting without first logging on to the application through the Login page. If your ITUAM administrator has enabled auto logon for your user ID, you will see the following message on the home page when you start ITUAM Web Reporting:

Welcome *username*, you are currently signed on as *userid*

If you are an ITUAM Web administrator, you can click Login to open the Login page and log on as another user if needed (see the steps under the following bullet, Manual log on). If you are an ITUAM Web end user, the Login page is inactive.

■ **Manual logon.** If your ITUAM administrator has not enabled auto logon for your user ID, you will see the following message on the home page when you start ITUAM Web Reporting:

Not currently signed in, please click Login to begin

To log on, do the following:

1. On the ITUAM Web Reporting home page, click Login to open the Login page.

2. Enter the following information, and then click OK:
   - Your user ID and password (required). If you do not know your user ID and password, contact your ITUAM administrator.

   The password is case-sensitive. Type the password exactly as provided by your ITUAM administrator.

   - Your company or organization name (if the Your Company or Organization box is present). Your ITUAM administrator determines whether this box is present on the Login page. For more information, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*.

   Your company/organization name is saved in a cookie so that you do not have to re-enter it each time that you log on.

The ITUAM Web Reporting home page reappears as shown in example Figure 1-1 on page 1-4.
Getting Started

Logging On To ITUAM Web Reporting

Figure 1-1 • ITUAM Web Reporting Home Page
Using the Menu Bar

The menu bar enables you to easily navigate ITUAM Web Reporting features. The use of the links and menus contained on the menu bar are discussed in the following chapters. Figure 1-2 provides an overview of the functions of each of the links and menus on the menu bar.

![ITUAM Web Reporting Toolbar](image)

Figure 1-2 • ITUAM Web Reporting Toolbar

Changing Your Password

*Note* • If you are an ITUAM Web end user and are using auto logon, the information in this section is not applicable. However, if you are an ITUAM Web administrator using auto logon, you can change the password of other users using the following steps.

Your ITUAM administrator assigns user IDs and passwords using the ITUAM Administrator program. If the Change Password check box is present on the Login page, you can change your password as follows:

1. Click **Login** to open the Login page.
2. Type your user ID, current password, and company or organization name (if required).
3. Select the Change Password check box and then click **OK**.
4. On the Change User Password Page, type your current password and the new password as directed. The password is alphanumeric and case-sensitive and can be a maximum of 16 characters.
5. Click **OK** to change the password and return to the home page.

Your ITUAM administrator determines whether the Change Password check box is included on the Login page. For more information, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*. 

---

*IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide* 1-5
Logging Off

Note • If you are an ITUAM end user and are using auto logon, this section is not applicable.

If you are an ITUAM Web administrator using auto logon, you can log on and off as other users during the same session by clicking Login and following the steps for a manual log on page 1-3.

If you are not using auto logon, click Logout to enable one user to log off and another to log on during the same session. The home page opens with the prompt:

Not currently signed in, please click Login to begin.

Viewing Online Help

To view online Help, click Help.

Timing Out

If you are inactive for a period longer then the amount of time specified on the Edit Configuration page (Admin ➤ Configuration), the ITUAM Web Reporting session times out. If the session has timed out, one of the following occurs when you attempt to perform another task:

■ If you are an ITUAM Web end user and are using auto logon, you are automatically logged out and directed to Please login. Simply click Login to log on automatically.

■ For all others, you are automatically logged out and are returned to the Login page to log on again.
Assigning Folder Security Permissions

**Note**  • Your ITUAM or Windows® administrator should have already set the required folder security permissions described in this section. For more information, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*.

All ITUAM Web Reporting users must have the following security permissions for the ITUAM program folders shown. If ITUAM is installed in the default location, the folders are in `C:\Program Files\IBM\ITUAM`.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Required Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Read &amp; Execute</td>
</tr>
<tr>
<td>Server\Web\temp</td>
<td>Full Control</td>
</tr>
<tr>
<td>Server\Reports\Published</td>
<td>Read &amp; Execute, Write</td>
</tr>
<tr>
<td>Admin</td>
<td>Read &amp; Execute</td>
</tr>
</tbody>
</table>
Running Reports

This chapter describes how to run reports in ITUAM Web Reporting.

**Note** For simplicity, the procedures in this section reflect commands in the Reports menu. However, these procedures are also applicable to spreadsheets. For example, if you are instructed to click Reports ▶ Run Reports, the corresponding sequence for spreadsheets is Spreadsheets ▶ Run Spreadsheets.

- **Introduction to Report Types** .......................................................... 2-2
- **Running Reports** ........................................................................... 2-3
- **Using Report Parameters** ............................................................... 2-4
- **About Account Codes** ................................................................. 2-7
- **Example: Running a Report** ......................................................... 2-8
- **Creating and Running Web User Created Reports** .................. 2-9
  - Creating or Updating a Web User Created Report .................... 2-9
  - Running a Web User Created Report ...................................... 2-10
  - Deleting a Web User Created Report .................................... 2-10
  - Example: Creating and Running a Web User Created Report .... 2-11
- **Creating and Viewing Published Reports** ............................. 2-12
  - Publishing Reports ................................................................. 2-12
  - Viewing Published Reports ..................................................... 2-14
  - Example: Creating and Viewing a Published Report ............... 2-16
  - Deleting Published Reports ..................................................... 2-17
Introduction to Report Types

There are four types of reports that you can generate using ITUAM Web Reporting:

- **Standard or Custom Reports.** ITUAM includes a variety of standard Crystal and SQL Server Reporting Services reports. These standard reports include invoice, budget, summary, trend, and variance reports in report, graph, and spreadsheet format (see Appendix A, Standard Reports).

  The report descriptions and examples used in this guide reflect the standard ITUAM reports. Typically, your report developer will customize the standard reports for your organization or will create new reports. Therefore, the parameters, look, and content of reports for your organization might differ.

  To run standard and/or custom reports, click Reports ➤ Run Reports and follow the steps in Running Reports on page 2-3.

- **ITUAM Web User Created Reports.** These reports are created using report templates that are supplied with ITUAM Web Reporting (see Templates on page A-102) or developed by your report developer. Template reports differ from the standard or custom reports discussed previously in that users can create reports that contain the data and format that they want directly within the ITUAM Web Reporting interface.

  To create a report, click Reports ➤ Create a Report and follow the steps in Creating and Running Web User Created Reports on page 2-9.

- **Published Reports.** These reports are created from generated reports. Publishing a report enables other ITUAM Web users to view the report with the data as it appeared at the time the report was generated.

  To publish a report, follow the steps in Creating and Viewing Published Reports on page 2-12.
Running Reports

This section provides the steps for running a report from the ITUAM Web Reporting application. You can also run and publish reports in batch mode as described in Creating and Viewing Published Reports on page 2-12.

To run a report:

1. Click Reports > Run Reports. The report page opens displaying reports categorized by groups.

2. To expand the group, click + next to the report group that contains the report that you want to run.

3. Links to the available reports appear. Click the link for the report that you want to run as shown in example Figure 2-1.

4. If the report requires parameters, enter the parameters on the parameters page and then click OK to generate the report. For a description of the standard parameters supplied with ITUAM, see Using Report Parameters on page 2-4.
Running Reports

You can do many things with the information in the generated report such as drill down on data and print and save the report. For more information, see Chapter 3, Working With Reports.

Note • Drill down is not available for graphs, spreadsheets, or ITUAM Web user created reports.

You can also publish the report so that others can view it in ITUAM Web Reporting. Published reports are saved with the data that was generated at the time the reports were published. For more information, see Publishing Reports on page 2-12.

Using Report Parameters

Table 2-1 provides a description of the report parameters that are supplied with ITUAM standard reports.

Your reports might use other parameters that are custom for your site. For information about creating custom parameters, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.

The parameter values that you enter are stored in a cookie so that you do not have to re-enter the values each time you run a report (unless you want to change the values).

Note • Parameters vary by report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Code Level</td>
<td>The account code level that you want to view in the report. For example, the account code AABBBBCC might contain three levels: the two-digit company code AA, the 6-digit division code AABBBB, and the 9-digit department code AABBBBCC. The resource use and charge data will reflect the level that you select. For more information about account codes, see About Account Codes on page 2-7.</td>
</tr>
<tr>
<td>Audit Type</td>
<td>The type of changes that you want to view in Client, Rate, and Transaction table audit reports: all changes, additions, updates, or deletions.</td>
</tr>
<tr>
<td>Calendar Period</td>
<td>The calendar period for the data that you want to appear in the report.</td>
</tr>
<tr>
<td>Display Graph</td>
<td>If this parameter is Y (the default), a graph appears before the report. If this parameter is N, the graph does not appear.</td>
</tr>
<tr>
<td>From/To</td>
<td>The beginning and end dates for the data that you want to appear in the report.</td>
</tr>
</tbody>
</table>

Table 2-1 • Report Parameters
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>This parameter provides data by the selected identifier. An <em>identifier</em> is a unique key that denotes the source of a resource that has been consumed (for example, a device name, server name, user ID, phone number).</td>
</tr>
<tr>
<td>Invoice Number</td>
<td>Some invoice reports contain separate invoices for the account codes selected. If this parameter is blank (the default), invoice numbering begins with 1. Use this parameter to begin invoice numbering from another number (if needed). Your ITUAM administrator determines whether this parameter appears for invoices. If this parameter is not available, the invoice number set in the CIMSConfigOptions table in the database is used and invoice numbers continue to increase sequentially each time you run an invoice. For example, if the last invoice in a report was 99, the next invoice that you run will begin with invoice number 100. For more information, refer to the <em>IBM Tivoli Usage and Accounting Manager Administrator’s Guide</em>.</td>
</tr>
<tr>
<td>Prorate</td>
<td>The amount that you want to prorate across accounts in proration reports.</td>
</tr>
<tr>
<td>Rate Code</td>
<td>This parameter provides data by the selected rate code or all rate codes. A <em>rate code</em> represents resource units consumed (for example, CPU time used, pages printed, e-mail message sent).</td>
</tr>
<tr>
<td>Rate Group</td>
<td>This parameter provides data for the selected rate group. A rate group contains rate codes.</td>
</tr>
<tr>
<td>Report Month</td>
<td>The month for the data that you want to appear in the report.</td>
</tr>
<tr>
<td>Report Year</td>
<td>The year for the data that you want to appear in the report.</td>
</tr>
<tr>
<td>Set the Date Range</td>
<td>The date range for the data that you want to appear in the report.</td>
</tr>
<tr>
<td>Start and End Value</td>
<td>The starting and ending identifier value.</td>
</tr>
</tbody>
</table>

*Table 2-1  • Report Parameters (Continued)*
### Starting and Ending Account Code

This parameter works in conjunction with the Account Code Level parameter and specifies the account codes for that level that appear in the report.

If you want all account codes for that level to appear in the report, click **Lowest Possible Account** for the starting account code and **Highest Possible Account** for the ending account code.

If you want specific account codes, click the appropriate start and end codes or click **Custom** and type the start and end codes.

### Transaction ID Start and End

This parameter provides data by the selected CICS transaction ID range. For example, if you want data for the following three transaction IDs: CESF, DEGV, and TINQ, type CESF as the start and TINQ as the end.

### Top N

This parameter specifies the number of account codes that appear in a report or the drill down for a report. For example, if you type 1, only the account code that used the most resources or incurred the most charges appears. If you type 2, the highest and second highest account codes appear.

### Zero Cost Processing Option

The Zero Cost Invoice report may be processed in two ways:

- **A-Factor Total.** This factors the invoice total by the zero cost amount.

- **B-Factor Rates.** This factors each resource rate by the zero cost amount.

### Zero Cost Amount

The zero cost amount. You can type this amount with or without the decimal point. For example, 100000 or 100000.00. For more information about zero cost, refer to the IBM Tivoli Usage and Accounting Manager Administrator's Guide.

---

**Table 2-1 • Report Parameters (Continued)**
About Account Codes

An account code is an alphanumeric string that identifies the hierarchy of a resource record. Account codes contain sufficient information to describe what resource was used by what entity. These codes may contain levels such as Company, Division, Cost Center, etc.

For example, if your organization cost center structure is:

Level 1  Company
Level 2  Division
Level 3  Department within division
Level 4  Cost Center within department
Level 5  Application within cost center

Your account code structure might be designed as shown in Table 2-2.

<table>
<thead>
<tr>
<th>DESCRIPTION (LEVEL)</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Account Code</td>
<td>AABBBBCCDDDAPP1</td>
</tr>
<tr>
<td>Company Code</td>
<td>AA</td>
</tr>
<tr>
<td>Division Code</td>
<td>BBBB</td>
</tr>
<tr>
<td>Department Code</td>
<td>CCC</td>
</tr>
<tr>
<td>Cost Center Code</td>
<td>DDD</td>
</tr>
<tr>
<td>Application Code</td>
<td>APP1</td>
</tr>
</tbody>
</table>

Table 2-2  • Example Account Code Structure

The account codes and account code levels that appear on the parameters page are set by your ITUAM administrator. For more information, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.
Example: Running a Report

Figure 2-2 provides an example of the parameters used to create an Invoice by Account Level report for the month of March. In this example, Application is the first level of the account code. Figure 2-3 shows the resulting report.

Figure 2-2 • Example Parameters for the Invoice by Account Level Report

Figure 2-3 • Example Invoice by Account Level Report
Creating and Running Web User Created Reports

This section describes how to create and run reports using the report templates provided with ITUAM. Note that templates created by your report developer may differ.

Creating or Updating a Web User Created Report

The report templates provided with ITUAM enable you to choose the rate codes that you want to appear in the report. You can specify that the report display the resource usage per rate code, the resource cost per rate code, or both usage and cost. All cost and usage is displayed by account code and rate code. Once you have created a report, you can update the report (for example, select different rate codes) at any time.

To create or update a report:

1. Click Reports ▶ Create a Report. The Build a Report page opens.

2. Enter or update the following parameters for the report:
   - Go to Report. Click New Report to create a new report or click an existing report to update the report.
   - Report Type. Click the report type that you want to create:
     - Resource (resource usage by account and rate code description)
     - Cost (charges by account and rate code description)
     - Both (resource and cost information)
   - Report Name (required). The name that you want to assign to the report.
   - Report Description. A brief description of the report.
   - Make visible to all users. If this check box is not selected (the default), the report is available only to those in your user group. If this check box is selected, the report is available to all ITUAM Web users.
   - Resource. In the column select boxes, choose the rate code that you want to appear in that column. You can choose up to four columns/rate codes for Both reports and eight columns/rate codes for Cost or Resource reports.
   - Decimal Places. Type the number of decimal digits that you want to appear in the resource usage amount.

3. If you are creating a new report, click Add. If you are updating a report, click Update.

Once created, reports appear on the Reports page (Reports ▶ Run Reports) under a report group determined by your ITUAM administrator (see Figure 2-4 on page 2-10 for an example). For more information about setting the report group for these reports, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.
Running a Web User Created Report

To run a report:

1. Click Reports ➤ Run Reports. The Reports page opens displaying reports categorized by groups.

2. Expand the report group that contains the created reports, and then click the report that you want to run as shown in example Figure 2-4.

![Example Links for Web User Created Reports](image)

3. Enter the parameters for the report on the parameters page and then click OK to generate the report. For a description of the parameters, see Using Report Parameters on page 2-4.

You can do many things with the information in the generated report such print and save the report. For more information, see Chapter 3, Working With Reports.

You can also publish the report so that others can view it in ITUAM Web Reporting. Published reports are saved with the data that was generated at the time the reports were published. For more information, see Publishing Reports on page 2-12.

Deleting a Web User Created Report

To delete a report:

1. Click Reports ➤ Create a Report.

2. On the Build a Report page, click the report in the Go to Report select box.

3. Click Delete and then click OK in the confirmation dialog box to delete the report.
Example: Creating and Running a Web User Created Report

Figure 2-5 shows the creation of a Both report called Storage Resource. Figure 2-6 shows the resulting report that has been run from the Reports menu.
Creating and Viewing Published Reports

Once you have generated a report, you can publish the report. Publishing a report enables other ITUAM Web users to view the report without having to regenerate it.

**Note** • Reports that involve a wide range of dates or account codes can require excessive system time and resources to generate. Consider publishing or saving these reports for quicker access (see Publishing Reports vs. Saving Reports).

Published reports can be created directly within ITUAM Web Reporting as described in this section or in batch. ITUAM includes a powerful feature that enables you to generate published reports in batch and then distribute the reports to recipients via e-mail. For more information about generating and distributing reports in batch, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*.

**Publishing Reports vs. Saving Reports**

Both publishing and saving a report saves a report that you have generated. However, publishing a report saves the report on the Web server so that you and others can view it from within ITUAM Web Reporting. (Your ITUAM administrator determines where the published reports are stored on the server. For more information, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*.)

Saving a report saves the report to the local or network drive that you choose. In this case, the report is not accessible via the ITUAM Web Reporting interface. For more information about saving reports, see Saving Reports on page 3-8.

**Publishing Reports**

**To publish a report:**

1. Run a report.
2. On the report page, click Publish. The Save Report window appears. Enter the following:
   - **Report File**. The file name of the published report. You can use the default file name or type another name. If you want to include the report in your favorites list, you need to use the default file name (see Working With Favorite Reports on page 4-2).
   - **Location**. Location specifies the subfolder name for the published reports within the overall published reports folder. By default, this folder is named Published and is in C:\Program Files\IBM\ITUAM\Server\Reports<type>. For example, if you click User, the published reports are stored in the user subfolder within the Published reports folder.
Location also determines the accessibility of the report as follows:

- **User.** The report is available to the specified user only. If you are an ITUAM Web administrator, you can publish reports for any user ID within your user group. If you are not an administrator, you can reports for your user ID only.

- **Group.** The report is available to those in your current user group.

- **Account.** The report is available to ITUAM users in a group that is allowed to view the selected client account code. (To enable client account code access to a group, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide.*) The **Account** option appears only if you are an ITUAM Web administrator.

- **Global.** The report is available to anyone using ITUAM Web Reporting. The **Global** option appears only if you are an ITUAM Web administrator.

**Note** • The preceding access permissions are applicable only within ITUAM Web Reporting—it does not affect the ability of Windows users to access reports from the hard drive. If you want to control access to reports via Windows, you need to set Windows security for the folders that contain the published reports. ITUAM Web users, however, must have the permissions shown in Assigning Folder Security Permissions on page 1-7.

- **Reporting Period.** The date period assigned to the report for storage and retrieval purposes. This date period does not affect the date of the data in the report.

- **Replace Existing Report.** Select this check box to replace any existing published report with the same file name with this report.

3 Click **OK** to publish the new report to the location that you specified.
Viewing Published Reports

Note • Links to published reports that are designated as favorite reports appear in the left side of the home page. Click these links to quickly access these reports. For more information about favorite reports, see Working With Favorite Reports on page 4-2.

To view a published report:

1 Click Reports ▶ View Published Reports.

2 The Published Reports page opens. The reports that appear on this page are determined by the location that was set when the report was published (see Publishing Reports on page 2-12) and the Date Range and Location parameters on the page (see Filtering the List of Published Reports on page 2-15).

3 Click the report date, name, or location (if present, see the following note) to open the report.

Note • By default, published reports include the full path to the folder that contains the report. You can choose to show or hide the path (see page 4-5).

Drill down capability in published reports varies by report.
Filtering the List of Published Reports

You can filter the list of published reports using the Date Range and Location parameters as follows.

**Date Range**
This parameter lists reports by the reporting period that was assigned when the published report was created (see Publishing Reports on page 2-12). This may or may not be the date of the data in the report.

**From and To**
Enter the beginning and end date of listed reports if you cannot select the date that you want from Date Range.

Click the Calendar button to choose a beginning or end date for listed reports.

**Location**
Click one of the following:

- **All**. All published reports that you can view appear.
- **Global**. All published reports that were assigned to a Global location appear.
- **User**. All published reports that were assigned to a User location that you can view appear.
- **Group**. All published reports that were assigned to a Group location that you can view appear.
- **Account**. All published reports that were assigned to an Account location that you can view appear. If you click a specific account code, published reports for only that account code appear.

Sorting the List of Published Reports

To sort the list of published reports by date or report, click Date or Reports, respectively.
Example: Creating and Viewing a Published Report

Figure 2-7 shows the creation of a published Invoice by Account Level report.

Figure 2-8 shows the link for the resulting report on the Published Reports page (Reports › View Published Reports).

Figure 2-7 • Example of Creating a Published Report

Figure 2-8 • Example Published Report Link
Deleting Published Reports

Note: To delete published reports, you need to have access to the server that contains the reports.

To delete published reports, start Windows Explorer and navigate to the Published folder. Delete the reports from the applicable subfolder.
Working With Reports

This chapter describes how to navigate and use generated reports.

**Working With Reports** ................................................................. 3-2
About the Report Interface ............................................................ 3-2
Using the Reporting Toolbar ......................................................... 3-3
Navigating Using the Group Tree ................................................... 3-4
Drilling Down in Reports ............................................................... 3-4
Publishing Reports ........................................................................ 3-8
Saving Reports ............................................................................... 3-8
Copying Text From a Report ......................................................... 3-8

**Working With Spreadsheets** ....................................................... 3-9
About the Spreadsheet Interface .................................................... 3-9
Publishing Spreadsheets ............................................................... 3-9
Opening a Spreadsheet in Excel ................................................... 3-10
Working With Spreadsheets in Excel ............................................. 3-10
Working With Reports

This section describes how to navigate and use reports. Except where noted, the information in this section is applicable to all report types.

The figures in this section reflect Crystal Reports XI using the default HTML viewer. If you are not using this setup, the interface will appear similar.

About the Report Interface

Figure 3-1 provides an introduction to the report interface. The use of the interface, including how to use the toolbar, is discussed in the following sections.
Using the Reporting Toolbar

This section provides an overview of the report toolbar options.

Printing a Report

To print a Crystal report, click the Print button. The Print button does not appear in the toolbar for Reporting Services reports. To print these reports, you must export the report to a PDF file from the toolbar.

Saving a Report

To save a report, click the Export button. For more information about saving reports, see page 3-8.

Navigating a Report

To navigate through the pages of a report, click the page arrows or type a page number. To open and close the Group Tree that appears to the left of the report, click the Show/Hide Group Tree button. For more information about the Group Tree, see page 3-4.

Zooming In or Out

To zoom in or out on a report, click a percentage in the the Zoom menu.
Searching Text in a Report

To search for text in the report, type the text that you want to search for and then click the Search button. To perform an advanced search, click the Advanced Search button.

Stopping a Report from Loading (ActiveX Viewer Only)

If you are using the ActiveX viewer, you can click the Stop Loading button to stop a report from loading. This button is available only when the report is loading.

Navigating Using the Group Tree

The Group Tree appears to the left of the report (see Figure 3-1 on page 3-2). This tree view enables you to navigate down to data.

Note • If the Group Tree does not appear, click the Show/Hide toggle button.

Similar to the manner in which Windows Explorer displays folders and files, items in the report are listed in the Preview tab as an expandable hierarchy.

To view the item in the report, click the item. To expand or collapse an item, click the + or - beside the item.

Drilling Down in Reports

For certain items in a report, you can drill down to view information specific to that item or you can drill down to generate a separate report for the item. For example, in invoices, you can drill down on resource units to open a report that breaks out the units by identifier (see Report Drill Down Example on page 3-6).

If you are using the ActiveX viewer, the cursor becomes a magnifying glass when you point to an item that enables you to drill down to more detailed information within the report.

The icon becomes a hand when you point to an item that enables you to drill down to another report.

If you are using the HTML viewer, the hand cursor appears for both types of drill down.
To drill down in a report:

1. Place the cursor on the appropriate item in the report. For example, a rate or charge.
2. Double-click the item. Detailed information about the item appears.
3. You can continue to drill down where allowed to view additional detailed information.

To drill down to another report:

1. Place the cursor on the appropriate item in the report. For example, an account code or resource units.
2. Click the item. Depending upon item that you click, the report either appears in the same browser window or in a separate window. If the report opens in a separate window, the parameters page for the report appears first.

Note • Drill down to another report is available only in invoice reports.

Closing the Drill Down View

To close the drill down view in a report:

If you are using the HTML viewer, click the Back button in the browser toolbar.

If you are using the ActiveX viewer, click the close button on the report toolbar or right-click the drill down view tab and then click Close Current Drill Down View.

To close a drill down report:

Click the close button in the browser window.
Report Drill Down Example

The drill down example shown in example Figure 3-2 shows a drill down on resource units.

Note that the possible identifiers that you can select include Usage Dates and Accounting Dates. Usage dates are the actual start and end dates in the CSR or CSR+ records that are processed by ITUAM. Accounting dates are derived from the usage end date as described in the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.

In Figure 3-3 on page 3-7, the identifiers Usage Dates and Process Name are selected.
Figure 3-3 • Select Report Parameters

Figure 3-4 shows the resulting report. The units are broken down by usage dates and process names.

Figure 3-4 • Drill Down by Identifier Report
Publishing Reports

See Publishing Reports on page 2-12.

Saving Reports

Note • Saving a report is distinct from the process of publishing a report. Saving a report saves the report to a local or network drive. When you save a report, users can access the report from this location. When you publish a report, users can access the report directly from the ITUAM Web Reporting application. For more information about published reports, see Creating and Viewing Published Reports on page 2-12.

ITUAM Web Reporting enables you to save reports that you generate so that you or other users can access the report again without regenerating the report. For example, if you run a daily report that others need to view, you can generate the report each day and save it in an accessible drive or folder.

Note • Reports that involve a wide range of dates or account codes can require excessive system time and resources to generate. Consider publishing or saving these reports for quicker access.

To save a report:

1 On the report page, click the Export button on the report toolbar.

2 Follow the instructions in the dialog boxes that are presented.

If you want to share the saved report with others, choose a network drive when you save the report.

Copying Text From a Report

To copy an item in a report, right-click the item, and then click Copy. The system places the text in the Windows clipboard, enabling you to paste the text into other applications.
Working With Spreadsheets

This section describes how to use ITUAM spreadsheets. When you run a spreadsheet, ITUAM Web Reporting presents the report data in Microsoft® Excel. You must have Excel installed on the client running the spreadsheet.

About the Spreadsheet Interface

Figure 3-5 provides an introduction to the spreadsheet interface. You can view and/or publish the spreadsheet from this interface or you can open the spreadsheet in Microsoft Excel and save, print, and/or edit the spreadsheet.

Publishing Spreadsheets

See Publishing Reports on page 2-12.
Opening a Spreadsheet in Excel

To open a spreadsheet in Excel:

Click Open with Excel.

The spreadsheet opens in Excel within the Web browser. You can then save, print, and/or edit the spreadsheet using the Excel commands and toolbar.

If the Excel toolbar does not appear, click the Tools button on the browser toolbar.

Working With Spreadsheets in Excel

To save a spreadsheet:

1. Click File ▶ Save As on the browser menu bar.

2. Navigate to the folder that you want to save the file in, and then enter the file name and file type in the File name and Save as type select boxes.

3. Click Save to save the file to the location you selected.

Note • You need to click Save As each time you want to save the spreadsheet. Clicking the Save button on the Excel toolbar will not save the spreadsheet.

For more information about the benefits of saving spreadsheets rather than regenerating them, see Saving Reports on page 3-8.

To print a spreadsheet:

1. Click File ▶ Print on the browser menu bar or the print button on the Excel toolbar.

To edit a spreadsheet:

Edit the spreadsheet as required and then follow the steps in To save a spreadsheet.

To close a spreadsheet in Excel:

Click Back to return to the ITUAM Web Reporting spreadsheet interface.

Note • Any changes you made to the spreadsheet while the report was open in Excel are not saved in ITUAM Web Reporting.
Administering ITUAM Web Reporting

This chapter describes user-specific and system-wide configuration settings for ITUAM Web Reporting.

Note • For simplicity, the procedures in this section reflect commands for reports. However, these procedures are also applicable to spreadsheets. For example, if you are instructed to click Favorites ➔ Add ➔ Reports, the corresponding sequence for spreadsheets is Favorites ➔ Add ➔ Spreadsheets.

Configuring User-Specific Settings ................................................. 4-2
Working With Favorite Reports .................................................... 4-2
Showing or Hiding Folder Paths for Published Reports ....................... 4-5
Selecting an Account Code Structure for Reports ............................... 4-5
Choosing a Crystal Report Viewer .................................................. 4-6
Changing Your E-mail Address ...................................................... 4-7
Resetting the Browser ................................................................. 4-7

Configuring System-Wide Settings ............................................... 4-8

Accessing ITUAM Financial Modeler and ITUAM Web Console ...........4-11
Configuring User-Specific Settings

The settings described in this section can be different for each ITUAM Web user. These settings are not applied system wide.

Working With Favorite Reports

You can designate reports as favorite reports. This feature enables you to easily access favorite reports from the Favorites page (see Figure 4-2 on page 4-4) or from shortcuts in the left frame of the home page (see Figure 4-1 on page 4-3).

**Note** • Although you can designate multiple reports as favorites, only the first five reports that you add as favorites will appear on the home page.

**To add a report as a favorite:**

1. Click Favorites ▶ Add ▶ Reports.

2. On the Maintain Favorites–Add Reports page, expand the report group that contains the report that you want, and then click the report.

The report is designated as a favorite as shown in the following example and appears on the Favorites page (see Figure 4-2 on page 4-4).

**Note** • When you add a report as a favorite, any published reports created from that report are also automatically included as favorites if the default file name was used when the published reports were created (see Publishing Reports on page 2-12). If a file name other than the default was used for a published report, the system will not add the report as a favorite and you cannot add the report manually.
To access a favorite report from a shortcut:

Click the report link in the left frame of the home page (see Figure 4-1). If the report has a correlating published report for the current period, the most current published report opens.

If the favorite report does not have a correlating published report for the current period, the parameters page for the report opens.

Figure 4-1  Favorite Report Links
To access a favorite report from the Favorites page:

1. Click Favorites \ Reports.

The Favorites page opens displaying a hierarchy of reports that you have saved as favorites.

2. Navigate to the appropriate report (see Figure 4-2) and expand it.

3. Do one of the following:
   - Click Run Report to run the report.
   - Click a published report (if available) to view the report. You can hide or display the folder path that appears for the published report. See Showing or Hiding Folder Paths for Published Reports on page 4-5.

To remove a favorite report:

1. Click Favorites \ Delete.

2. On the Maintain Favorites–Remove Reports page, click the report that you want to remove.

The report is removed from Favorites list.

Note • Removing a favorite report simply removes the report from your list of favorites. It does not delete the report from the system.
Showing or Hiding Folder Paths for Published Reports

By default, published reports that appear on the Published Reports and Favorites pages include the full path to the folder that contains the report. You can choose to show or hide these paths.

To hide or display folder paths of reports:

1. Click Admin > User Options.
2. On the Set User Options page, do the following:
   - To show the full folder paths on the Published Reports and/or Favorites pages, click Y in the appropriate box.
   - To hide folder paths, click N in the appropriate box.
3. Click Update.

The system shows or hides the directory paths as you requested.

Selecting an Account Code Structure for Reports

If your ITUAM administrator has assigned multiple account code structures to your user group, you can choose the account structure that you want to appear in reports.

To select the account code structure:

1. Click Admin > User Options.
2. On the Set User Options page, click the account code structure that you want to use in the Account Code Structure select box.
Choosing a Crystal Report Viewer

In most cases, your ITUAM administrator will have set the appropriate Crystal Report viewer for your browser. (For more information, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.) However, you can change the viewer as needed from ITUAM Web Reporting. The viewer that you select should be based on the specifics of your browser and computer. For the advantages and disadvantages of each viewer, see page 4-8.

**Note** • If you are using SQL Server Reporting Services for reporting, use the Default viewer.

**To choose a Crystal Report viewer:**

**Note** • The following steps are applicable to selecting a viewer for an individual ITUAM Web user only. To set the viewer for all users, see Configuring System-Wide Settings on page 4-8. ITUAM Web Reporting uses the viewer set for the individual user if it differs from viewer set for all users.

1. Click Admin ▶ User Options.

2. On the Set User Options page, click one of the following in the Crystal Web Viewer select box:

   - **Default.** This option uses the viewer set on the Edit Configuration page (see page 4-8).

   - **ActiveX.** This option works only in Internet Explorer.

   - **Java using Browser JVM.** This option works in Netscape Navigator or Internet Explorer. This viewer requires the Java™ Virtual Machine. Because this viewer might be more difficult to set up, the use of the HTML or ActiveX viewer is recommended.

   - **HTML.** This option is appropriate for users with lower powered computers with minimal memory (64MB or less). It offers a smaller feature set.

3. Click Update to change the viewer.
Changing Your E-mail Address

ITUAM includes an automatic report distribution feature. If your ITUAM administrator has enabled this feature for your user ID or user group, you will receive published reports via e-mail. Your ITUAM administrator determines the reports that you will receive.

If needed, you can change the e-mail address at which you receive reports. To change your e-mail address:

1. Click Admin ▶ User Options.
2. In the Email Address box, type your e-mail address, and then click Update.

For more information about publishing and distributing reports in batch, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.

Resetting the Browser

Important! You should reset the browser only after consulting IBM. This feature is for debugging purposes only.

You can reset your browser to the default values by clicking Admin ▶ User Options and then clicking OK under Browser Reset.
Configuring System-Wide Settings

You must be an ITUAM Web administrator to edit the configuration settings described in the section. If you are not an administrator, you can view these settings in a read-only capacity.

These configuration settings are saved to the ITUAM database and are applied to all ITUAM Web users.

**Note** • Many of these settings can also be configured using ITUAM Administrator.

To edit the configuration settings:

1. Click Admin » Configuration.

2. Edit the settings on the Edit Configuration page as follows:

   - **ITUAM Data Source ID and ODBC DSN (not editable).** These fields identify the database that ITUAM Web Reporting is pointing to. The value for the **ITUAM Data Source ID** setting is always Default. The default ITUAM Data Source is defined in ITUAM Administrator. The default ITUAM Data Source points the ODBC Data Source shown in the **ODBC DSN** box, which points to the database. For more information about setting up ITUAM Data Sources and ODBC Data Sources, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*.

   - **ODBC DSN (not editable).** The name of the ODBC-compliant Data Source that the default ITUAM Data Source is pointing to.

   - **Localization ID (LCID) (not editable).** The LCID assigned to the user’s regional setting in Windows.

   - **Organization Name and Address Fields.** Address information for your organization (maximum of 255 characters for each box). This information appears in the standard invoices provided with ITUAM.

   - **Path to Standard/Custom/Published Reports Folder.** The paths to the folders that contains the standard, custom, and published reports used for Web reporting (maximum of 255 characters for each box).

   - **Invoice Number.** This invoice number is used only if the Invoice Number report parameter is not available (see page 2-5).

   - **Session Timeout Minutes.** The number of minutes of inactivity that are allowed before users are automatically logged out of ITUAM Web Reporting. The minimum is 1 minute and the maximum is 9999 minutes. The default is 60 minutes.

   **Note** • If you change this setting, the change will not take effect during the same session. You need to log out and the log on again.
• **Crystal Web Viewer.** This setting determines the particular Crystal Viewer used to view reports. You can choose one of the following:

**Note** • If you are using SQL Server Reporting Services for reporting, leave this box set to Default.

• **Default.** For Crystal Reports 9 or 10, the default is the HTML viewer.

• **ActiveX.** This option works only in Internet Explorer. This viewer has the following advantages and disadvantages:

  **Advantage:** This viewer provides more features than the HTML viewer provides.

  **Disadvantage:** This viewer requires that the Crystal Smart Viewer for ActiveX be installed on the user’s computer (for more information, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*). The user might not have the administrative privileges required to install and run the viewer.

• **Java using Browser JVM.** This option works in Netscape Navigator or Internet Explorer. This viewer requires the Java Virtual Machine. Because this viewer might be more difficult to set up, the use of the HTML or ActiveX viewer is recommended.

• **HTML.** This option works in Internet Explorer or Netscape Navigator. This viewer has the following advantages and disadvantages:

  **Advantage:** This viewer works with any browser and does not require any additional files or set up.

  **Disadvantage:** This viewer provides fewer features than the ActiveX viewer provides.

• **Display Account Code Selection to Level.** This setting determines the level of account codes that appear in the *Starting Account Code* and *Ending Account Code* lists on a report parameters page. For example, if you type 1, only the top level account codes appear. However, if you type 3, the first, second, and third level account codes appear.

• **Current Database Version (not editable).** The version of the database currently used by ITUAM.

• **Last Reporting Date.** The last reporting date that ITUAM Web end users can view. For example, if the date is December 31 2010, end users cannot view reports for dates after December 2010. The default is December 31 2199.

**Note** • ITUAM Web administrators can view reports for any date.
3 When you are finished, click **Update Configuration** to change the settings.

**Note** • Update Configuration also refreshes additional configuration options that are set in ITUAM Administrator and stored in the Web server cache. For more information about the configuration options that you can set for ITUAM Web Reporting, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*.

**About Updating Identifiers**

A key feature of viewing invoices in ITUAM Web Reporting is the ability to drill down on the units consumed for a resource by identifier. This feature uses the CIMSRateIdentifiers table, which contains the rate codes that are processed from the input resource file(s) and correlates them to their corresponding identifier names in the CIMSIIdent table.

If the identifiers in and/or a rate code or codes in the input file have changed, the CIMSRateIdentifiers table will retain unused data in addition to the current data. Although this does not cause processing problems, the table can accumulate a large amount of data. You can click **Update Identifiers Cache** to update the table so that it contains only the current data; however, in most cases this step will already be completed by your ITUAM administrator.

For more information about maintaining identifiers, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*.
Accessing ITUAM Financial Modeler and ITUAM Web Console

If your ITUAM administrator has enabled access to ITUAM Financial Modeler and/or ITUAM Web Console for your user group, links to these applications appear in the Admin menu.

ITUAM Financial Modeler provides an interface for performing IT finance-related tasks, such as cost analysis and allocation and rate calculation.

ITUAM Web Console provides an interface for viewing job log files.

For more information about these applications, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.
Using Transactions

This chapter describes how to create miscellaneous, recurring, and credit transactions.

**Working With Transactions** ................................................................. 5-2
Adding Transactions ................................................................. 5-3
Editing Transactions ................................................................. 5-4
Deleting Transactions ................................................................. 5-4
Navigating Transactions ................................................................. 5-4
Working With Transactions

The CSR file is used to input data into ITUAM. This file provides usage data from any IT source in a common format. CSR files are generated from usage metering files produced by systems in your organization.

In some circumstances, you might want to generate a CSR file for occurrences that are not contained in a usage metering file. For example, you might want to generate a CSR file to apply a credit for an overcharge or to charge for a one time occurrence such as the cost of providing a computer to a new employee. In these cases, you can create a transaction that contains the chargeback information that you want to include in the CSR file.

In summary, a transaction enables you to generate charges or credits for any item or resource that is not contained in a usage metering file.

There are three types of transactions:

- **Miscellaneous Transactions.** These are transactions that occur on a one-time basis. For example, charging for the services of a consultant who worked on a project for two days.

- **Recurring Transactions.** These are transactions that re-occur over a period of time. For example, charging for a set number of computers that are delivered to a department each quarter.

- **Credit Transactions.** These are transactions that apply a credit for resources units consumed or monetary charges.

**Note** • To process the transactions, you need to use the ITUAM Data Collector for Transactions. For more information about this collector, contact IBM.
Adding Transactions

To add transactions:

1. Click Admin ➤ Transactions ➤ Miscellaneous/Recurring/Credit. Note that
   Miscellaneous, Recurring, and Credit are separate commands.

2. On the transaction list page, click Add.

3. On the add transaction page, enter the following parameters for the transaction:

   - **Account Code or account code levels.** Depending on the configuration set by your ITUAM administrator for your user group, the first setting that appears on the page will be either Account Code, in which you can enter an overall account code, or account code level boxes, in which you can enter levels of the account code. For more information about configuring this setting, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.

   - **Rate Code.** The rate code for the transaction.

   - **Shift Code (optional).** The shift code for the transaction. Shift codes are set by your ITUAM administrator. For more information, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.

   - **Amount.** The amount of the transaction. Usually this figure is in resource units, for example, 500 computers, but it can also be monetary. If monetary, you can type this amount with or without the decimal point. For example, 1000 or 1000.00. Credit amounts need to be specified by a minus sign (e.g., -1000).

   - **From/To Date (Miscellaneous and Credit Transactions only).** The date range that the transaction occurred.

   - **Frequency (Recurring Transactions only).** The frequency that the transaction should occur (that is, every month, every 6 months, every quarter, etc.). Frequency is based on the calendar year (January–December).

   - **Enter transaction on (Recurring Transactions only).** The period in which the transaction should be processed. The number of periods correlates to the value in the Frequency select box. For example, if Every 6 months is selected for frequency, six periods appear (Period 1 represents January and July, Period 2 represents February and August, etc.)

     Note that the date parameter used by the Transactions collector determines which recurring transactions are processed. For example, if the collector is run in June with a date parameter of Current, and the transaction is set to Once a year and Period 1 (January), the transaction will not be processed.

   - **Begin/End Processing on (Recurring Transactions only, optional).** The date range in which you want recurring transactions to be processed. ITUAM will not process recurring transactions before or after these dates. The default is the first day of the current month to December 31, 2199.

   - **Notes.** Any relevant comments.

4. When you are finished, click Add to save the transaction and return the transaction list page. If you do not want to save the transaction click Return.
Using Transactions

Working With Transactions

Editing Transactions

To edit miscellaneous and credit transactions:

1. On the transaction list page, click the date for the transaction(s) that you want to edit in the Set the Date Range or From/To select boxes.

2. Click Refresh. All transactions within the specified date range appear.

3. Click the Edit button for the transaction that you want to edit. For a description of the settings that you can edit, see Adding Transactions on page 5-3.

4. When you have completed the edits, click Update to save the edits and return to the transaction list page. If you do not want to save the edits, click Return.

To edit recurring transactions:

1. Click Edit for the transaction that you want. For a description of the settings that you can edit, see Adding Transactions on page 5-3.

2. When you have completed the edits, click Update to save the edits and return to the transaction list page. If you do not want to save the edits, click Return.

Deleting Transactions

To delete transactions:

On the transaction list page, click the Delete button for the transaction that you want to delete. You can also delete the transaction from the edit transaction page. In this case, the delete transaction page opens indicating the date and time that the transaction was deleted.

Navigating Transactions

You can navigate to the transaction pages by:

- Clicking Admin ▶ Transactions.
  - Or

- Within an open transaction list page, clicking another transaction type in the Select Type select box.
Troubleshooting

This chapter describes problems you may encounter while using ITUAM Web Reporting and how to solve them.

**Note** • While some problems can be resolved by ITUAM Web end user, others must be resolved by the ITUAM Web administrator or your organization’s system administrator.

**General Problems** ...................................................... 6-2
Computer locks up or runs slowly ........................................... 6-2

**Connection Problems** .................................................. 6-2
Unable to connect to the ITUAM Web Reporting Web site .................. 6-2

**Web Reporting Problems** ............................................ 6-3
Problems accessing the Web site or generating reports ....................... 6-3
Reports are missing from reports lists ...................................... 6-10
Reports take a long time to generate ...................................... 6-10
Web reporting session is timing out before or after session timeout value .......... 6-10
An error message appears When ActiveX Data Objects (ADO) or ODBC is used to open a database connection in an ASP page .................. 6-10
Published reports do not appear on the Published Reports page ............. 6-11

**Crystal XI Problems** .................................................... 6-12

**SQL Server Reporting Services Problems** .......................... 6-13
Report Server cannot decrypt the symmetric key message appears ............ 6-13
The user account does not have adequate permissions message appears when you try to generate a report ............................. 6-13
General Problems

Computer locks up or runs slowly

The computer might not have enough memory to process. Try running the application on a PC with more memory (preferably 256 MB or more).

Connection Problems

Unable to connect to the ITUAM Web Reporting Web site

Verify the following:

- Your Internet or network connection is working properly.
- You have appropriate network permissions and are using Internet Explorer 5.5 or later.
- You entered the correct URL.
- You have the required security permissions for the ITUAM program folders discussed in Assigning Folder Security Permissions on page 1-7.

For assistance troubleshooting these problems, contact your system administrator.
Web Reporting Problems

Problems accessing the Web site or generating reports

The following are problems that might occur as you are using the ITUAM Web Reporting Web site to generate reports. The problems are presented in the order are they are most likely to occur, beginning with accessing the Web site.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot access the Web site</td>
<td>Verify that you have appropriate network permissions and are using Internet Explorer 5.5 or later on the Windows platform. Verify the following:</td>
</tr>
<tr>
<td></td>
<td>■ Your Internet or network connection is working properly.</td>
</tr>
<tr>
<td></td>
<td>■ You have appropriate network permissions and are using Internet Explorer 5.5 or later.</td>
</tr>
<tr>
<td></td>
<td>■ You entered the correct URL.</td>
</tr>
<tr>
<td></td>
<td>■ You have the required security permissions for the ITUAM program folders discussed in Assigning Folder Security Permissions on page 1-7.</td>
</tr>
</tbody>
</table>
### Troubleshooting

#### Web Reporting Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
</table>
| Web site is not opening properly or is having problems starting        | If the following error appears, see page 6-10 for a possible solution: Microsoft OLE DB Provider for ODBC Drivers error '80004005' [Microsoft] [ODBC Driver] Data source name not found and no default driver specified.  
If this does not resolve the problem, try the following:  
- Restart IIS.  
  - Click Start > Run. In the Open box, type iisreset /restart, and then click OK.  
- Check the IIS security settings (refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide for more information).  
- Install the latest service pack for Microsoft SQL Server.  
- If you are using Crystal Reports 9, make sure that you have installed Service Pack 2. |
| If using multiple Web sites, Web sites other than the default Web site do not open. The following message appears:  
Server Error in '/virtual directory name' Application                  | In IIS Manager, navigate to the virtual directory for the Web site and do the following:  
1. Expand the virtual directory.  
2. Right-click the CIMSReporting folder, and then click Properties.  
3. Click the Create button next to the Application name box.  
4. Click OK when you are finished.  
Make sure that you copied the ...
.\IBM\ITUAM\Server\Web folder to create the folder for the Web site. You must recreate the Web site folder from the Web folder each time that you upgrade to a new ITUAM release. For more information, refer to the information on using multiple databases for reporting in the IBM Tivoli Usage and Accounting Manager Administrator’s Guide. |
## Troubleshooting

### Web Reporting Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cannot log on.</strong></td>
<td>Make sure that you are typing the correct user ID and password. Note that the user password is case-sensitive.</td>
</tr>
<tr>
<td><strong>Auto logon feature is not working.</strong></td>
<td>In ITUAM Administrator, check the following:</td>
</tr>
<tr>
<td></td>
<td>1. The <strong>Enable Intranet Auto Logon</strong> check box is selected on the Web tab of the Configuration dialog box. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td>2. The correct domain name and user ID is entered for the user in the User Maintenance dialog box.</td>
</tr>
<tr>
<td></td>
<td>Note that if IIS is using anonymous access rather than Windows authenticated access, the auto logon feature is not available. For more information about setting the IIS authentication method, refer to the <em>IBM Tivoli Usage and Accounting Manager Administrator’s Guide</em>.</td>
</tr>
<tr>
<td><strong>Report parameters page does not open when a report is selected—a 405 error appears</strong></td>
<td>Make sure that ASP.NET is installed and enabled as follows:</td>
</tr>
<tr>
<td></td>
<td>1. Click <strong>Start &gt; Run</strong>. In the <strong>Open</strong> box, enter <code>aspnet_regiis.exe -i</code> preceded by the path. For example, <code>Windows\Microsoft.NET\Framework\&lt;version number&gt;\aspnet_regiis.exe -i</code>.</td>
</tr>
<tr>
<td></td>
<td>2. Make sure that ASP.NET is enabled. For instructions, refer to the <em>IBM Tivoli Usage and Accounting Manager Administrator’s Guide</em>. (This is applicable to Windows 2003 only).</td>
</tr>
<tr>
<td></td>
<td>3. Apply any Microsoft critical updates with latest .NET service pack.</td>
</tr>
</tbody>
</table>
Troubleshooting
Web Reporting Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report parameters page opens, but report is not generated from the page—one of the following error occurs:</td>
<td>In ITUAM Administrator, click System Administration ▶ Database ▶ Database Object. In the Database Objects Manager dialog box, add any database objects that do not exist in the database (i.e., Exists = No). If this does not solve the problem, drop all stored procedures, indexes, triggers, and views in the Database Objects Manager dialog box and then create them again. Important! Do not drop the tables in the Database Objects Manager dialog box. Dropping a table removes the table and its data from the database. To view the detailed error message, run the report directly from Crystal Reports (not the Web).</td>
</tr>
<tr>
<td>A time-out message appears immediately or the following message appears:</td>
<td></td>
</tr>
<tr>
<td>-2147192179 An error has occurred on the server in attempting to access the data source</td>
<td></td>
</tr>
<tr>
<td>A 404 “page not found” error appears.</td>
<td>Make sure that ASP.NET is installed and enabled as described in the solution for a preceding problem, Report parameters page does not open when a report is selected—a 405 error appears.</td>
</tr>
<tr>
<td>Problem</td>
<td>Solution(s)</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>An error message appears when trying to run a spreadsheet or publish a report.</td>
<td>If you receive the following messages when you try to run a spreadsheet or publish a report, you do not have the correct security permissions for the ITUAM program folders discussed in Assigning Folder Security Permissions on page 1-7. Contact your ITUAM administrator or system administrator.</td>
</tr>
<tr>
<td>Spreadsheet Message</td>
<td>Your Web Userid does not have sufficient access rights to create spreadsheets. Please have the ITUAM Web Administrator enable write permissions for the IIS Web User to the ..\IBM\ITUAM\Server\Web folder on the ITUAM Server. Consult the ITUAM Administrator's Guide for more information.</td>
</tr>
<tr>
<td>Published Report Message</td>
<td>Your Web Userid does not have sufficient access rights to create published reports. Please have the ITUAM Web Administrator enable write permissions for the IIS Web User to the ..\IBM\ITUAM\Server\Reports\Published folder on the ITUAM Server. Consult the ITUAM Administrator's Guide for more information.</td>
</tr>
<tr>
<td>You are using Crystal Reports 10 and a clientdoc.dll failure occurs.</td>
<td>Do the following:</td>
</tr>
<tr>
<td></td>
<td>In Crystal License Manager, make sure that the Crystal licenses are entered for the Crystal Reports Advanced and Embedded editions.</td>
</tr>
<tr>
<td></td>
<td>Make sure that the Crystal Report Application Server service is running (Control Panel ➤ Administrative Tools ➤ Services).</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Web Reporting Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are using Crystal Reports XI and one of the following messages appears:</td>
<td>This error message occurs on Windows 2003 computers running IIS 6.0 where the default application pool is running under the Network Service account. This account does not have sufficient rights to the fields and registry needed to create a copy of the report in the Crystal Reports enterprise system. To resolve this problem, do the following:</td>
</tr>
</tbody>
</table>
| Failed to read data from report file C:\WINDOWS\TEMP\tmp.rpt. | 1 In IIS Manager, expand the Application Pools folder.  
2 Right-click DefaultAppPool, and then click Properties.  
3 In the DefaultAppPool Properties dialog box, click the Identity tab.  
4 Make sure that the Predefined radio button is selected, and then select the Local System account from the Predefined drop-down list.  
5 Restart IIS. |
| Reason: Failed to open print engine for C:\WINDOWS\TEMP\tmpreport\<report>. Ensure that CRPE32 is installed on this computer. |  |
| Max processing time or Max records limit reached | This error occurs because the Crystal Reports Page Server and Report Application Server return a maximum of 20,000 records by default. To resolve this problem, refer to the information on setting up Crystal Reports XI for use with ITUAM in the *IBM Tivoli Usage and Accounting Manager Administrator's Guide*. For more possible Crystal XI problems and solutions, see page 6-12. |
### Troubleshooting

**Web Reporting Problems**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
</table>
| You are using SQL Server Reporting Services and the following message appears:  
The User Account `<account name>` does not have adequate permissions in Reporting Services. Make sure the User Account belongs to the Reporting Service's `<role name>` Role. | Make sure that the Windows user account that is accessing the Web site has been assigned to the Reporting Services role as described in *Assigning Folder Security Permissions* on page 1-7.  
For more possible Reporting Services problems and solutions, see page 6-13. |
| Report is generated, but the following problems occur: | |
| ■ General problems viewing the report. For example, headers and data do not appear. | Change the viewer used to view reports. You can change the viewer system-wide or by user as described in *Chapter 4, Administering ITUAM Web Reporting*.  
*Note:* If you are using the Crystal Reports ActiveX viewer, you may not have administrative privileges to allow the viewer to be automatically downloaded and installed on the computer on which you are trying to run the report. Use the Crystal HTML or Java viewer instead. |
| ■ Old or sample data appears in the report. | One or more old loads have not been removed from the database. Unload the old data. For more information, about tracking and working with database loads, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*. |
| ■ Cannot drill down in reports. | Certain items do not have any additional information available. If you place the cursor on an item and the cursor icon becomes a magnifying glass or a hand, you can drill down. If it does not, there is no detailed information available about the item. |
| ■ Cannot print report when using the HTML viewer with Crystal Reports. The following message appears:  
There was an error opening this document. This file cannot be found. | When prompted to open or save the file, click *Save* and then click *Open*. |
**Troubleshooting**

Web Reporting Problems

**Reports are missing from reports lists**

If reports that you used to be able to access are missing from reports lists, your ITUAM administrator may have removed access to those reports from your user group. Contact your ITUAM administrator.

**Reports take a long time to generate**

Make sure that your Internet or network connection is working properly. It could be that excessive network usage is slowing down either the connection or the server. If you are using the ActiveX viewer and would like to stop a report that has begun loading, click the Stop Loading button (see *Stopping a Report from Loading (ActiveX Viewer Only)* on page 3-4).

If you or other users would like to view the same report again, you can avoid waiting for the report to generate by publishing or saving the report. For more information, see *Publishing Reports* on page 2-12 or *Saving Reports* on page 3-8.

**Web reporting session is timing out before or after session timeout value**

If you change the Session Timeout Minutes value, the change will not take effect until you restart IIS.

**An error message appears When ActiveX Data Objects (ADO) or ODBC is used to open a database connection in an ASP page**

When you use ActiveX Data Objects (ADO) or ODBC to open a database connection in an ASP page, you may receive the following error message:

Microsoft OLE DB Provider for ODBC Drivers error '80004005' [Microsoft] [ODBC Driver ] Data source name not found and no default driver specified.

**Solution**

**Note**  
Make sure that you have completed the steps for setting the user authentication for the Web site (refer to the *IBM Tivoli Usage and Accounting Manager Administrator's Guide*) before continuing with this solution.

The Windows 2000/2003 user account that is used to process the request for the ASP page does not have sufficient permissions to read the registry key that stores the specified ODBC Driver's configuration information. The Driver parameter in a DSN-less connection string specifies the ODBC driver that is used to establish the database connection.

Grant the Windows user account Read access to the specified ODBC Driver registry key as follows:

1. Determine which account is used to process the request for the ASP page.
2. From the Start menu, click Run, type regedt32.exe, and then click OK to start Registry Editor.
3 In the HKEY_LOCAL_MACHINE window, browse to the HKLM\SOFTWARE\ODBC\ODBCINST.INI key. The ODBCINST.INI key contains a subkey for each ODBC Driver that is installed on the server.

4 Click the Driver registry key for the driver that is specified in the ADO connection string.

5 From the Security menu, click Permissions.

6 Add the user account that you identified in Step 1 to the list of users who can access this key, and select the Read check box for this user.

7 Click Apply, and then close Registry Editor.

This information was taken from the Microsoft Knowledge Base Article 306345.

**Published reports do not appear on the Published Reports page**

Make sure that you have set the Date Range and Location parameters correctly. Also, you might not have access to a report because of the report’s location. For example, the report was published to a folder for another user. For more information, see Creating and Viewing Published Reports on page 2-12

If you are using Crystal XI for reporting and you have not purchased the full Crystal Reports Server license, published reports cannot be viewed in Crystal Reports. To view published report in this situation, enable the option to publish reports in PDF in ITUAM Administrator (refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide). If this option is enabled, reports are published as PDF files and Acrobat Reader rather than Crystal Reports is invoked when the file is viewed. Note that the group tree that is used for navigation in a report does not appear in reports published as PDF files.
Crystal XI Problems

The following are general troubleshooting steps for Crystal XI.

**Important!** Follow the steps in the order presented and see if a step solves the problem before continuing to the next step.

1. Install Crystal Reports Service Pack 1.

2. Delete and re-enter the Crystal Reports and Crystal Reports Server license keys.

   To access the Crystal Reports license key, start Business Objects License Manager (Start ➤ Programs ➤ Business Objects 11).

   To access the Crystal Reports Server license key, start BusinessObjects Enterprise Central Management Console and click License Key. To log on to the Central Management Console, open your Web browser and go to the following page:


   Where *webserver* is the name of the Web server. If you changed this default virtual directory on the Web server, you will need to type your URL accordingly.

3. In Central Management Console, click Servers and then do the following:

   a. Select the check box for each server that is disabled (indicated by a server with a red circle), and then click Enable.

   b. If the preceding step does not enable a server, click the server check box and then click Delete. Close the Central Management Console and then go to Services on the Windows operating system and restart the Crystal Report Application Server. To access Services, in Windows Control Panel, double-click Administrative Tools ➤ Services.

4. Perform a full uninstall of Crystal Reports Server and Crystal Reports, restart the server, and then reinstall both applications as described in the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*. Make sure that you re-enter the license keys.
SQL Server Reporting Services Problems

Report Server cannot decrypt the symmetric key message appears

If you encounter the following error, you need to delete encrypted data from the Report Server database and restart the ReportServer service.

The report server cannot decrypt the symmetric key used to access sensitive or encrypted data in a report server database. You must either restore a backup key or delete all encrypted content and then restart the service. Check the documentation for more information.

To delete the encrypted data and restart, make sure that the ReportServer services is running, and then do the following:

1. Click Start ▶ Run.
2. In the Open box, type rskeymgmt -delete, and then click OK.
3. Type Y to delete the data, and the press <Enter>.

The user account does not have adequate permissions message appears when you try to generate a report

If the following message appears when you try to generate a report:

The User Account <account name> does not have adequate permissions in Reporting Services. Make sure the User Account belongs to the Reporting Services's <role name> Role

Make sure that the Windows user account that is accessing the Web site has been assigned to the Reporting Services role as described in the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.
Troubleshooting

SQL Server Reporting Services Problems
Standard Reports

This appendix describes the standard reports provided with ITUAM.

About ITUAM Reports ................................................................. A-4
Location of ITUAM Reports ....................................................... A-4
Report Naming Conventions ...................................................... A-5

Conventions Used in This Appendix ............................................. A-5

Reports by File Name .............................................................. A-6

Graphs .................................................................................... A-8
Cost Trend—Accounts Graph ..................................................... A-8
Cost Trend—Rates Graph .......................................................... A-9
Resource Trend Graph ............................................................. A-10

Drill Down Reports ................................................................. A-11
Invoice Drill Down for Rate Group Report ................................ A-11
Invoice Drill Down for Rate Group by Date Report ..................... A-13
Invoice Drill Down for Units Report ......................................... A-14

Reports .................................................................................... A-16
Client Audit Report ................................................................. A-16
Rate Audit Report ................................................................... A-18
Transaction Audit Report ....................................................... A-20
Batch Report ............................................................................ A-22
Account Budget for Period and YTD Report ............................. A-23
Line Item Budget for Period and YTD Report ............................. A-24
Configuration Report ............................................................ A-25
CICS Transaction Report ....................................................... A-26
Client Report ........................................................................... A-27
Account Summary Daily Report ............................................. A-28
Account Summary Daily 2 Report ........................................... A-29
DB2 Summary Report ............................................................. A-30
Detail by Rate Group Report ................................................... A-31
Standard Reports

Detail by Rate Group/Identifier Report .................................................. A-32
Detail Rate Codes by Identifiers ................................................................. A-33
Detail Rate Codes by Identifiers/Account .................................................. A-34
Invoice by Account Level V2 Report ......................................................... A-36
Alternate Invoice Report ........................................................................... A-36
Account Total Invoice Report .................................................................... A-38
Invoice with Budget Report ....................................................................... A-39
Invoice Report ............................................................................................ A-41
Invoice by Account Level Report ............................................................... A-43
Invoice with Shifts Report ......................................................................... A-45
Run Total Invoice Report ........................................................................... A-47
Run Total Percent Report .......................................................................... A-48
Run Total Rate Group Percent Report ....................................................... A-49
Run Total Invoice with Shifts ..................................................................... A-50
Zero Cost Center Invoice Report ............................................................... A-51
Zero Cost Center Factor Report ............................................................... A-53
Job Cost Report ........................................................................................... A-54
MS SQL Server 2000 Resource Report ...................................................... A-56
Percentage Report ...................................................................................... A-57
Rate Report ................................................................................................ A-58
Top Cost Report .......................................................................................... A-59
Top 10 Bar Graph Report ............................................................................ A-61
Top 10 Pie Chart Report .............................................................................. A-63
Top Accounts for Rate Report .................................................................... A-65
Cost Trend Report ....................................................................................... A-66
Cost Trend by Rate Report .......................................................................... A-67
Resource Usage Trend Report ..................................................................... A-68
Transaction Report ...................................................................................... A-69
Cost Variance Report .................................................................................. A-70
Cost Variance Drill Down Report ............................................................... A-71
Resource Variance Report ......................................................................... A-72
Account Summary by Week Report ............................................................ A-74
Account Summary by Week—Wide Report ............................................... A-75
Account Summary YTD Report ................................................................... A-76
Account Summary YTD—Wide Report ....................................................... A-77
Spreadsheets ................................................................. A-78
Invoice Spreadsheet ...................................................... A-78
Run Total Invoice Spreadsheet ......................................... A-79
Invoice by Rate Group Spreadsheet .................................. A-80
Invoice by Account Code Spreadsheet ............................... A-81
Proration by Total Amount Spreadsheet ............................. A-82
Proration by Rate Code Spreadsheet ................................ A-83
Proration by Rate Group Spreadsheet ................................. A-84
Top 10 Accounts for Rate Spreadsheet ............................... A-85
Account Summary Week Spreadsheet ................................. A-86
Account Summary YTD Spreadsheet ................................ A-87
Account Summary YTD by Rate Spreadsheet ....................... A-88
Account Summary YTD Cost by Rate Group Spreadsheet ........ A-89

Crosstab Reports ............................................................. A-90
Daily Crosstab—Charges .................................................. A-90
Daily Crosstab—Usage ..................................................... A-91
Detail by Identifier Crosstab ............................................. A-92
Detail by Identifier by Date Crosstab ................................. A-93
Monthly Crosstab—Charges .............................................. A-94
Monthly Crosstab—Usage ................................................ A-95
Summary Crosstab—Charges ............................................ A-96
Summary by Rate Group Crosstab—Charges ....................... A-97
Summary Crosstab—Usage ............................................... A-98
Summary by Rate Group Crosstab—Usage ......................... A-99
Weekly Crosstab—Charges .............................................. A-100
Weekly Crosstab—Usage ................................................ A-101

Templates ................................................................. A-102
Report Both Template .................................................. A-102
Report Cost Template .................................................. A-104
Report Resource Template ........................................... A-105
Spreadsheet Both Template .......................................... A-105
Spreadsheets Cost Template .......................................... A-107
Spreadsheets Resource Template .................................. A-108
About ITUAM Reports

ITUAM produces chargeback and resource accounting reports based on IT usage data from your organization. To help you to easily create reports that display the information that you need, ITUAM includes a variety of standard reports that you can use as templates. Standard reports are available as .rpt files for Crystal Reports and .rdl files for SQL Server Reporting Services.

This appendix provides a description of each standard report. The reports examples shown in this appendix reflect Crystal Reports; however, the same data would appear in a Reporting Services report.

**Note** • The ability to run some reports is dependent on the database you are using, the reporting tool that you are using, or both and is noted where applicable.

In addition, some reports may not apply to the ITUAM package that you are using.

For more information about the different types of reports available, see *Introduction to Report Types* on page 2-2.

Location of ITUAM Reports

If ITUAM was installed in the default location, reports are located in the following folders. Each of these folders contains the subfolders Standard, Custom, and Published. For example, ReportsMSRS\Standard, ReportsMSRS\Custom, and ReportsMSRS\Published.

Crystal Reports

■ ...\ReportsORADB2 (contains Crystal reports for Oracle and DB2)
■ ...\ReportsSQL (contains Crystal reports for SQL Server)

SQL Server Reporting Services Reports

■ C:\Program Files\IBM\ITUAM\Server\ReportsMSRS

How ITUAM Web Reporting Determines the Report Folder to Use

The folder that is used for Web reporting is determined when the ITUAM database is initialized. Database initialization is performed as part of the ITUAM setup process. For more information about initializing the database and selecting the report folder, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*. 
Report Naming Conventions

The following is the file naming convention for the ITUAM standard reports for Crystal Reports and SQL Server Reporting Services:

Character 1: The type of report: (G)raph, (I)Drill down, (R)eport, (S)preadsheet, (X)Crosstab

Character 2, 3, 4: Description of report (if template, TMP)

Character 5: Function of report: (R)esource, (C)ost, (B)oth, (U)ser, (X)Other

Note: With the exception of the Job Cost Report, all cost (C) reports reflect data in the CIMSSummary table.

Character 6, 7, 8: Numbering sequence for reports of the same type (for example, invoice, budget, trend)

For example, the file name RBGTC001 represents the following:

R = Report
BGT = Budget
C = Cost
001 = Report number

Conventions Used in This Appendix

The reports listed in this appendix are grouped by type (graphs, drill down reports, reports, spreadsheets, crosstab reports, and templates) and are presented in alphabetical order by file name.

Each report includes a description with the following information:

File name. The name of the report file.

Stored Procedure. The stored procedure used for the report (if applicable). A stored procedure is a set of SQL statements that can perform both queries and actions that allow the system to generate reports.

Drill down. The drill down features for the report (if applicable).

Parameters. The parameters for the report such as starting and ending account codes, account code level, and from and to dates. For a description of these parameters, see Using Report Parameters on page 2-4.
For easy reference, the following lists each standard report by file name and provides the page number where you can find the report description. Reports that begin with RTMP or STMP are report templates, which are in the ...Standard/Templates folder.

GTRDC001 page A-8
GTRDC002 page A-9
GTRDR001 page A-10
IINXC001 page A-11
IINXC002 page A-13
IINXC004 page A-14
RACLX001 page A-16
RARTX001 page A-18
RATRX001 page A-20
RBATR001 page A-22
RGBTC001 page A-23
RGBTC002 page A-24
RCFGX001 page A-25
RCICR001 page A-26
RCLTX001 page A-27
RDAYC001 page A-28
RDAYC002 page A-29
RDB2R001 page A-30
RDETR001 page A-31
RDETR002 page A-32
RDRIR001 page A-33
RDRIR002 page A-34
REX2R001 page A-35
RINVC001 page A-36
RINVC002 page A-36
RINVC003 page A-38
RINVC004 page A-39
RINVC006 page A-41
RINVC007 page A-43
RINVC009 page A-45
RINVC009 page A-45
RIVTC001 page A-47
RIVTC002 page A-48
RIVTC003 page A-49
RIVTC004 page A-50
Standard Reports

- **RIVZC001** page A-51
- **RIVZC002** page A-53
- **RJOBC001** page A-54
- **RMS2R001** page A-56
- **RPERX001** page A-57
- **RRATX001** page A-58
- **RTMPB001** page A-102
- **RTMPC001** page A-104
- **RTMPR001** page A-105
- **RTOPC001** page A-59
- **RTOPC002** page A-61
- **RTOPC003** page A-63
- **RTOPC004** page A-65
- **RTRDC001** page A-66
- **RTRDC002** page A-67
- **RTRDR001** page A-68
- **RTRNX001** page A-69
- **RVARC001** page A-70
- **RVARC002** page A-71
- **RVARR001** page A-72
- **RWDKR001** page A-73
- **RWEKCO01** page A-74
- **RWEKCO02** page A-75
- **RYTDC001** page A-76
- **RYTDC002** page A-77
- **SINVC001** page A-78
- **SINVC002** page A-79
- **SINVC003** page A-80
- **SINVC004** page A-81
- **SPERX001** page A-82
- **SPERX002** page A-83
- **SPERX003** page A-84
- **STMPB001** page A-105
- **STMPC001** page A-107
- **STMPR001** page A-107
- **STOFC004** page A-85
- **SWEKC001** page A-86
- **SYTDC001** page A-87
- **SYTDC002** page A-88
- **SYTDC003** page A-89
- **XDAYC001** page A-90
- **XDAYR001** page A-91
- **XDETR001** page A-92
- **XDETR002** page A-93
- **XMONC001** page A-94
- **XMONR001** page A-95
- **XSUMC001** page A-96
- **XSUMC002** page A-97
- **XSUMR001** page A-98
- **XSUMR002** page A-99
- **XWEKCO01** page A-100
- **XWEKR001** page A-101
Graphs

Cost Trend—Accounts Graph

File name: GTRDC001

Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total charges for all account codes for each month for the parameters selected followed by charges for individual account codes for each month.

Drill down: None

Parameters:

- Report Year
- Account Code Level
- Starting and Ending Account Code

Report Example

Figure A-1  Cost Trend—Accounts Graph Example
Standard Reports

Cost Trend—Rates Graph

File name: GTRDC002

Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total charges for all rate codes for each month for the parameters selected followed by charges for individual rate codes for each month.

Drill down: None

Parameters:

- Report Year
- Starting and Ending Account Code

Report Example

Figure A-2  •  Cost Trend—Rates Graph Example
Resource Trend Graph

File name: GTRDR001

Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total resource usage for all rate codes for each month for the parameters selected followed by resource usage for individual rate codes for each month.

Drill down: None

Parameters:
- Report Year
- Starting and Ending Account Code

Report Example

![Resource Trend Graph Example](image-url)
Drill Down Reports

Drill down reports enable you to view a breakdown of resource units by an identifier or identifiers. Drill down reports are invoked from other reports and cannot be run independently.

Invoice Drill Down for Rate Group Report

File name: IINXC001

Stored Procedure: CIMSSP_Drilldown_by_RateGroup

This report enables drill down of the charges for a rate group by identifier name. For example, the report in Figure A-4 on page A-12 provides a drill down of a rate group for charges associated with the identifier name Process Name. Charges for each rate code within the rate group are broken down by the identifier values for Process Name.

This report invokes from the following reports.

- Invoice with Budget (see page A-39)
- Invoice (see page A-41)
- Invoice by Account Level or Invoice by Account Level V2 (see page A-43)
- Invoice with Shifts (see page A-45)
- Zero Cost Center Invoice (see page A-51)

Drill down: None

Parameters:

- Identifier name
- All other parameters are supplied by the invoice report
Report Example

Figure A-4 • Invoice Drill Down for Rate Group Report Example
**Invoice Drill Down for Rate Group by Date Report**

**File name:** IINXC002

**Stored Procedure:** CIMSSP_Drilldown_by_RateGroup_Date

This report is similar to the Invoice Drill Down for Rate Group report (see page A-11). However, it also provides a breakdown of the data by date.

**Drill down:** None

**Parameters:**
- Identifier name
- All other parameters are supplied by the invoice report

**Report Example**

![Invoice Drill Down for Rate Group by Date Report Example](image)

*Figure A-5 • Invoice Drill Down for Rate Group by Date Report Example*
Invoice Drill Down for Units Report

File name: IINXC004

Stored Procedure: CIMSSP_Drilldown_by_Rate

This report enables drill down of resource units by up to five identifier names. For example, the report in Figure A-6 on page A-15 provides a drill down of resource units by the identifier values associated with the identifier names Process Name and Usage Dates.

This report invokes from the following reports:

- Alternate Invoice (see page A-36)
- Invoice with Budget (see page A-39)
- Invoice (see page A-41)
- Invoice by Account Level or Invoice by Account Level V2 (see page A-43)
- Invoice with Shifts (see page A-45)
- Run Total Invoice 2 (see page A-50)
- Zero Cost Center Invoice (see page A-51)

Drill down: None

Parameters:

- Identifier name
- All other parameters are supplied by the invoice report
Report Example

Figure A-6  •  Invoice Drill Down for Units Report Example
Standard Reports

Reports

Client Audit Report

**Note** • This report requires a SQL Server database and Crystal Reports.

File name: RACLX001

Stored Procedure: CIMSSP_AuditClient

This report tracks changes to the CIMSClient table and contains the following:

- Date and time the change was made
- The type of change that was made:
  - U = update to existing data
  - I = addition of new data
  - D = deletion of data
- Windows user ID
- Client account code
- Old account name (if applicable)
- New account name (if applicable)

Drill down: None

Parameters:

- From and To Date
- Audit Type
Report Example

In this example, the account code PAY was added (I and U) and then deleted (D). The account name for account code RTM was changed from Retirement to Retirement (Yearly).

Figure A-7 • Client Audit Report Example
Rate Audit Report

Note • This report requires a SQL Server database and Crystal Reports.

File name: RARTX001

Stored Procedure: CIMSSP_AuditRate

This report tracks changes to the CIMSRate table and contains the following:

■ Date and time the change was made

■ The type of change that was made:
  • U = update to existing data
  • I = addition of new data
  • D = deletion of data

■ Windows user ID

■ Rate code

■ Old and new rate value

■ Old and new rate per resource unit or per thousand unit indicator:
  • M (Per thousand units)
  • Blank (Per unit)

■ Old and new resource conversion factor:
  • 1 (Divide total resource value by 60)
  • 2 (Divide total resource value by 3600)
  • 3 (Divide total resource value by 1000)
  • 4 (Multiply total resource value by 60)
  • 5 (Divide total resource value by 60000)
  • # (Multiple total resource value by user-defined number)
  • Blank (No conversion factor)

■ Old and new zero cost indicator:
  • N (The rate will not be included in zero cost calculations)
  • Blank (The rate will be included in zero cost calculations)

Drill down: None
Parameters:
- From and To Date
- Rate Code
- Audit Type

Report Example

In this example, the rate code TEST was added (I and U) and then deleted (D). The rate values for rate codes Z001 and Z002 were increased.

Figure A-8  • Rate Audit Report Example
**Transaction Audit Report**

**Note**  •  This report requires a SQL Server database and Crystal Reports.

**File name:** RATRX001

**Stored Procedure:** CIMSSP_AuditTransaction

This report tracks changes to the CIMSTransaction table and contains the following:

- Date and time the change was made
- The type of change that was made:
  - U = update to existing data or transaction marked as deleted
  - I = addition of new data
- User ID (usually the Windows user ID or SQL Server user ID)
- Account code
- Old and new rate code
- Old and new amount

**Drill down:** None

**Parameters:**

- From and To Date
- Audit Type
Report Example

In this example, a miscellaneous transaction for COM Servers Windows was added (I) and then marked for deletion (U). A credit transaction was added for account code ATM Server Windows.

![Transaction Audit Report Example](image-url)
**Batch Report**

File name: RBATR001

Stored Procedure: CIMSSP_Batch

This report provides z/OS batch job data for the parameters selected. This data is taken from the CIMSDetail table.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Batch Report Example](image_url)
Account Budget for Period and YTD Report

File name: RBGTC001

Stored Procedure: None

This report provides actual, budget, and difference charges by account code for the parameters selected. This report includes totals for the calendar period selected and year to date (YTD).

This report reflects the amount for the Overall Account Budget for the account code as set in the CIMSClientBudget table. For more information about setting budgets, refer to the IBM Tivoli Usage and Accounting Manager Administrator’s Guide.

Drill down: None

Parameters:

- Starting and Ending Account Code
- Account Code Level
- Calendar Period

Report Example

![Figure A-11 • Account Budget for Period and YTD Report Example](image-url)
Line Item Budget for Period and YTD Report

**Note** • This report requires a SQL Server database.

File name: RBGTC002

**Stored Procedure:** CIMSSP_LineItem_Budget

This report provides actual, budget, and difference charges by account code, rate group and rate code description for the parameters selected. This report includes totals for the calendar period selected and YTD.

This report reflects the amount for the individual resource budgets for the account code as set in the CIMSClientBudget table. For more information about setting budgets, refer to the *IBM Tivoli Usage and Accounting Manager Administrator’s Guide*.

**Drill down:** None

**Parameters:**
- Account Code Level
- Calendar Period
- Starting and Ending Account Code

**Report Example**

![Figure A-12 • Line Item Budget for Period and YTD Report Example](image-url)
Configuration Report

File name: RCFGX001

Stored procedure: None

This report provides information contained in the CIMSConfig table.

Drill down: None

Parameters: None

Report Example

Figure A-13 • Configuration Report Example
CICS Transaction Report

File name: RCICR001

Stored Procedure: CIMSSP_CICS

This report provides data for CICS transactions by transaction ID for the parameters selected. This data is taken from the CIMSDetail table.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Trans ID Start
- Trans ID End

Report Example

![CICS Transaction Report Example](image)

Figure A-14 • CICS Transaction Report Example
Client Report

File name: RCLTX001

Stored procedure: None

This report provides the information contained in the CIMSClient table for the parameters selected.

Drill down: None

Parameters:
- Starting and Ending Account Code

Report Example

Figure A-15 • Client Report Example
Account Summary Daily Report

File name: RDAYC001

Stored Procedure: CIMSSP_Summary_Day

This report provides total daily and monthly charges by account code and rate code description for the parameters selected.

Drill down:
- Double-click a day or the charge for a day and a breakdown of charges by rate code description for the day appears.

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-16 • Account Summary Daily Report Example
Standard Reports

Account Summary Daily 2 Report

File name: RDAYC002

Stored Procedure: CIMSSP_Summary_Day

This report is similar to the Account Summary Daily report (see page A-28). However, the month (rather than the account code) appears as the top level of the report.

Drill down:
- Double-click a day or the charge for a day and a breakdown of charges for the day by account code appears. Double-click an account code and a breakdown of charges for the day by rate code description appears.

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-17 • Account Summary Daily 2 Report Example
Standard Reports

DB2 Summary Report

File name: RDB2R001

Stored Procedure: CIMSSP_DB2

This report provides DB2 data for the parameters selected. This data is taken from the CIMSDetail table.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-18 • DB2 Summary Report Example
**Standard Reports**

- **Detail by Rate Group Report**

  **File name:** RDETR001

  **Stored Procedure:** CIMSSP_Drilldown_by_RateGroup

  This report provides total resource units used for the first eight rate code descriptions in a rate group for the parameters selected. If applicable, a total for the next highest level of the account code appears. For example, in Figure A-19, total units appear for account codes ATM Servers WINDOWS ROCA-DEMO, ROCA-MAIL1, and ROCA-SRV1. The sum of these totals appears for account code ATM Servers Windows (the next highest level).

  **Drill down:** None

  **Parameters:**

  - Rate Group
  - Account Code Level
  - Starting and Ending Account Code
  - From and To Date

  **Report Example**

  ![Figure A-19 • Detail by Rate Group Report Example](image-url)
Standard Reports

Detail by Rate Group/Identifier Report

**File name:** RDETR002

**Stored Procedure:** CIMSSP_Drilldown_by_RateGroup_Identifier

This report is similar to the Detail by Rate Group report (see page A-31). However, the resource units are broken down by identifier value for the identifier name selected.

**Drill down:** None

**Parameters:**

- Rate Group
- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Identifier

**Report Example**

In this example, units are broken down by the values for the identifier **Folder**.

![Image of Report Example](image_url)

**Figure A-20 • Detail by Rate Group/Identifier Report Example**
Detail Rate Codes by Identifiers

File name: RDRIR001

Stored Procedure: CIMSSP_Detail_I5_R5

This report shows resource units consumed for a maximum of five rate codes and five identifiers.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Rate Codes (5 maximum)
- Identifiers (5 maximum)

Report Example

In this example, there are two identifiers (FEED and FOLDER) and two resources (MS Windows Folder Disk Usage and MS Windows Files in Folder).

![Figure A-21 • Detail Rate Codes by Identifiers Report Example](image-url)
Detail Rate Codes by Identifiers/Account

File name: RDRIR002

Stored Procedure: CIMSSP_Detail_I5_R5

This report shows resource units consumed by account code for a maximum of five rate codes and five identifiers.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Rate Codes (5 maximum)
- Identifiers (5 maximum)

Report Example
In this example, there are two identifiers (FEED and FOLDER) and two resources (MS Windows Folder Disk Usage and MS Windows Files in Folder).
MS Exchange 2000 Resource Report

File name: REX2R001

Stored Procedure: CIMSSP_Detail_Resource

This report provides Exchange 2000 Server data for the parameters selected. This data is taken from the CIMSDetail table.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Usage and Accounting Manager](image)

Figure A-22 • MS Exchange 2000 Resource Report Example
Standard Reports

Invoice by Account Level V2 Report

File name: RINVC001


Alternate Invoice Report

File name: RINVC002

Stored Procedure: CIMSSP_Summary

This report provides charges by account code and rate code description for the parameters selected. An optional graph showing total expenses by account code is also included.

Drill down:

- Double-click a bar on the graph and the invoice appears.
- Click the units for a rate and a new page appears to enable a drill down of units by identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14).
- Double-click a rate code description or its corresponding rate or charge and the next lower level of the account structure appears. This drill down can be continued through the account structure.

Parameters:

- Account Code Level
- Invoice Number
- Display Graph
- Starting and Ending Account Code
- From and To Date
Report Example

Figure A-23  •  Alternate Invoice Report Example
**Account Total Invoice Report**

File name: RINVC003

**Stored Procedure:** CIMSSP_Account_Summary

This report provides the total charges by each level of the account code structure for the parameters selected.

**Drill down:**
- Click the Invoice link and a complete invoice for the account code level appears (see Invoice Report on page A-41).

**Parameters:**
- Starting and Ending Account Code
- From and To Date

**Report Example**

![Account Total Invoice Report Example](image)

Figure A-24 • Account Total Invoice Report Example
Invoice with Budget Report

**Note** • This report requires a SQL Server database.

**File name:** RINVC004

**Stored Procedure:** CIMSSP_LineItem_Budget

This report provides charges by account code, rate code description, and rate group for the parameters selected. This report also includes a Budget and Variance field for the calendar period selected and YTD Charges, Budget, and Variance fields.

**Drill down:**

- Click the units for a rate and a new page appears to enable a drill down of units by identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14).

- Click the rate group name in the **Total** line and a new page appears to enable a drill down of charges by identifier. This page invokes the report Invoice Drill Down for Rate Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see page A-13).

**Parameters:**

- Account Code Level
- Calendar Period
- Invoice Number
- Starting and Ending Account Code
Report Example

Figure A-25 • Invoice with Budget Report Example
Invoice Report

File name: RINVC006

Stored Procedure: None

This report provides charges by account code, rate code description, and rate group for the parameters selected. This report is invoked by clicking the Invoice link for the account code in the following reports.

- Account Total Invoice (see page A-36)
- Top Cost (see page A-59)
- Top 10 Bar Graph (see page A-61)
- Top 10 Pie Chart (see page A-63)

Drill down:

- Click the units for a rate and a new page appears to enable a drill down of units by identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14).

- Click the rate group name in the Total line and a new page appears to enable a drill down of charges by identifier. This page invokes the report Invoice Drill Down for Rate Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see page A-13).

Parameters:

- All parameters are supplied by the report from which the invoice is invoked.
Report Example

Figure A-26 • Invoice Report Example
Invoice by Account Level Report

File name: RINVC007

Stored Procedure: CIMSSP_Summary

This key report provides charges by account code, rate group, and rate code description for the parameters selected. An optional graph showing total expenses by account code is also included.

Drill down:

- Double-click a bar on the graph and the invoice appears.
- Click the units for a rate and a new page appears to enable a drill down of units by identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14).
- Click the rate group name and a new page appears to enable a drill down of charges by identifier. This page invokes the report Invoice Drill Down for Rate Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see page A-13).
- (Invoice by Account Level V2 only) Double-click a rate code description or its corresponding rate or charge and the next lower level of the account structure appears. This drill down can be continued through the account structure.

Parameters:

- Account Code Level
- Invoice Number
- Display Graph
- Starting and Ending Account Code
- From and To Date
Report Example

Figure A-27 • Invoice by Account Level Report Example (Crystal Reports)
**Invoice with Shifts Report**

**File name:** RINVC009

**Stored Procedure:** CIMSSP_Summary_Shift

If the CIMSSummary table contains multiple shift codes for a rate code, this report provides charges by account code, rate group, and rate code description broken down by shift for the parameters selected.

**Drill down:**
- Double-click a bar on the graph and the invoice appears.
- Click the units for a rate and a new page appears to enable a drill down of units by identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14).
- Click the rate group name in the Total line and a new page appears to enable a drill down of charges by identifier. This page invokes the Invoice Drill Down for Rate Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see page A-13) report.

**Parameters:**
- Account Code Level
- Invoice Number
- Display Graph
- Starting and Ending Account Code
- From and To Date
Report Example

![Invoice with Shifts Report Example](image)

Figure A-28 • Invoice with Shifts Report Example
# Run Total Invoice Report

**File name:** RIVTC001

**Stored Procedure:** CIMSSP_Summary

This report provides total charges by rate group and rate code description for the parameters selected.

**Drill down:**
- Double-click a rate code description or its corresponding units, rate, or charge and a breakdown of data by account code appears.

**Parameters:**
- Account Code Level
- Starting and Ending Account Code
- From and To Date

**Report Example**

![Run Total Invoice Report Example](image)

**Figure A-29 • Run Total Invoice Report Example**
Standard Reports

Run Total Percent Report

File name: RIVTC002

Stored Procedure: CIMSSP_Summary

This report is the same as the Run Total Invoice report (see page A-47) except that the drill down includes percent total by account code in addition to units, rate, and charge.

Drill down:

- Double-click a rate code description or its corresponding units, rate, or charge and a breakdown of data by account code appears.

  You can set the number of account codes that appear in the drill down using the Top N parameter. For example, if you type 2 as the Top N parameter, only the account codes with the highest and second highest charges appear when you drill down. If you leave the Top N parameter blank, all account codes for the parameters selected appear.

Parameters:

- Account Code Level
- Top N
- Starting and Ending Account Code
- From and To Date
Run Total Rate Group Percent Report

File name: RIVTC003

Stored Procedure: CIMSSP_Summary

This report provides charges and percentage by rate groups for the parameters selected.

Drill down:

- Double-click the charge or percentage for a rate code description and breakdown of data by account code appears.

You can set the number of account codes that appear in the drill down using the Top N parameter. For example, if you type 2 as the Top N parameter, only the account codes with the highest and second highest charges appear when you drill down. If you leave the Top N parameter blank, all account codes for the parameters selected appear.

Parameters:

- Account Code Level
- Top N
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-30 • Run Total Rate Group Percent Report Example
Run Total Invoice with Shifts

File name: RIVTC004

Stored Procedure: CIMSSP_Summary

This report is the same as the Run Total Invoice report (see page A-47) except that the units, rate, and charges for each rate code description are broken down by shift if the CIMSSummary table contains multiple shift codes for a rate code.

Drill down:

- Double-click a rate code description or its corresponding units, rate, or charge and a breakdown of data by account code appears.

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Figure A-31  Run Total Invoice with Shifts Report Example](image-url)
Zero Cost Center Invoice Report

File name: RIVZC001

Stored Procedure: None

This report provides zero cost invoicing by account code for the parameters selected. You can adjust the total invoice amount or the amount for each rate by the zero cost amount.

This report first displays the Zero Cost Center Factor Report. The Zero Cost Center Factor Report shows the zero factor difference between the total amount due for all account codes and the zero cost amount. You can run the Zero Cost Center Factor Report independently (see page A-53).

Drill down:

- Click the units for a rate and a new page appears to enable a drill down of units by identifier. This page invokes the report Invoice Drill Down for Rate (see page A-14).

- Click the rate group name in the Total line and a new page appears to enable a Drill down of charges by identifier. This page invokes the report Invoice Drill Down for Rate Group (see page A-11) or Invoice Drill Down for Rate Group by Date (see page A-13).

Parameters:

- Starting and Ending Account Code
- Account Code Level
- From and To Date
- Invoice Number
- Zero Cost Processing Option
- Zero Cost Amount
Report Examples:

**Figure A-32 • Zero Cost Center Invoice—Factor Total Report Example**

**Figure A-33 • Zero Cost Center Invoice—Factor Rates Report Example**
Zero Cost Center Factor Report

File name: RIVZC002

Stored Procedure: None

This report appears as the first report in the Zero Cost Center Invoice (see page A-51); however, you can also run this report independently. The last page of this report provides the zero factor difference between the total amount due for all account codes and the zero cost amount.

Drill down:

- Double-click a rate code description or its units, rate or charge and a breakdown of charges by account code appears.

Parameters:

- Starting and Ending Account Code
- From and To Date
- Zero Cost Amount

Report Example

![Figure A-34 • Zero Cost Center Factor Report Example](image-url)
## Job Cost Report

**Note** • This report requires a SQL Server database.

**File name:** RJOBC001

**Stored Procedure:** CIMSSP_JobCost

This report provides costs by job name. Rather than using costs from CIMSSummary table, this report calculates costs directly using rate code values and options (rate shifts, resource conversion, etc.) from the CIMSRate table.

The following is a description of each of the columns in this report:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Jobname identifier value.</td>
</tr>
<tr>
<td>Account</td>
<td>Account code.</td>
</tr>
<tr>
<td>Steps</td>
<td>Number of steps.</td>
</tr>
<tr>
<td>Jobs</td>
<td>Number of jobs.</td>
</tr>
<tr>
<td>CPU Cost</td>
<td>Cost for rate code Z003 (Mainframe CPU Minutes) + Z020 (TSO CPU Minutes).</td>
</tr>
<tr>
<td>Tape I/O Cost</td>
<td>Cost for rate code Z007 (Tape SIOs).</td>
</tr>
<tr>
<td>Disk I/O Cost</td>
<td>Cost for rate code Z006 (Disk SIOs).</td>
</tr>
<tr>
<td>Other I/O Cost</td>
<td>Cost for rate code Z021 (TSO Inputs) + Z022 (TSO Outputs).</td>
</tr>
<tr>
<td>Card Input Cost</td>
<td>Cost for rate code Z014 (Input Records).</td>
</tr>
<tr>
<td>Print Cost</td>
<td>Cost for rate code Z016 (Lines Printed—Local) + Z017 (Pages Printed—Local) + Z018 (Print Time Minutes—Local).</td>
</tr>
<tr>
<td>Other Cost</td>
<td>Other costs.</td>
</tr>
<tr>
<td>Job Cost</td>
<td>Sum of preceding cost columns: CPU Cost through Other Cost.</td>
</tr>
</tbody>
</table>

**Drill down:**

- Click any item in a line and a breakdown of for all items in the line appears.

**Parameters:**

- Account Code Level
- Starting and Ending Account Code
- From and To Date
Report Example

Figure A-35 • Job Cost Report Example
Standard Reports

MS SQL Server 2000 Resource Report

File name: RMS2R001

Stored Procedure: CIMSSP_Detail_Resource

This report provides SQL Server 200 trace file data for the parameters selected. This data is taken from the CIMSDetail table.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![MS SQL Server 2000 Resource Report Example](image-url)

Figure A-36  •  MS SQL Server 2000 Resource Report Example
Percentage Report

File name: RPERX001

Stored Procedure: CIMSSP_Summary

This report provides the total charge by account code for the parameters selected and specifies the percentage of that charge in relationship to the total charges for all account codes. This report also provides a breakdown of the percentage by rate group and rate code description for each account code.

Drill down:

- Double-click an account code and a breakdown of percentage by rate group appears.
- Double-click a rate group and a breakdown of percentage by rate code description appears.

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-37 • Percentage Report Example
Rate Report

File name: RRATX001

Stored procedure: None

This report provides the information contained in the CIMSRate and CIMSRateGroup tables.

Drill down: None

Parameters: None

Report Example

![Figure A-38  Rate Report Example](image)
## Top Cost Report

**File name:** RTOPC001

**Stored Procedure:** CIMSSP_Summary

This report provides the account codes with the highest charges for the parameters selected. For example, if you type 3 as the Top N parameter, the three account codes with the highest charges appear (see example Figure A-39 on page A-60). If you leave the Top N parameter blank, the account codes with the ten highest charges appear.

**Drill down:**

- Click the **Invoice** link and a complete invoice for the account code level appears (see **Invoice Report** on page A-41).
- Double-click an account code or its corresponding percent or charge and a breakdown of charges by rate group appears.

**Parameters:**

- Top N
- Account Code Level
- Starting and Ending Account Code
- From and To Date
Report Example

Figure A-39 • Top Cost Report Example
Top 10 Bar Graph Report

File name: RTOPC002

Stored Procedure: CIMSSP_Summary

This report is similar to the Top Cost Report (see page A-59). However, it provides accounts codes with the 10 highest charges for the parameters selected and it provides the data in bar graph as well as table format.

Drill down:
- Click the Invoice link and a complete invoice for the account code level appears (see Invoice Report on page A-41).
- Double-click an account code or its corresponding percent or charge and a breakdown of charges by rate code description appears in both bar graph and table format.

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date
Report Example

**Note** • In the following example, there are only five account codes for the account code level selected.

![Top 10 Bar Graph Report Example](image)

**Figure A-40 • Top 10 Bar Graph Report Example**
Top 10 Pie Chart Report

File name: RTOPC003

Stored Procedure: CIMSSP_Summary

This report is similar to the Top Cost Report (see page A-59). However, it provides accounts codes with the 10 highest charges for the parameters selected and it provides the data in pie chart as well as table format.

Drill down:

- Click the Invoice link and a complete invoice for the account code level appears (see Invoice Report on page A-41).
- Double-click an account code or its corresponding percent or charge and a breakdown of charges by rate code description appears in both pie chart and table format.

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date
Report Example

**Note** • In the following example, there are only five account codes for the account code level selected.

![Image of Top 10 Pie Chart Report Example](image)

**Figure A-41** • Top 10 Pie Chart Report Example
Top Accounts for Rate Report

File name: RTOPC004

Stored Procedure: CIMSSP_Summary

This report provides the account codes with the highest usage of a specified rate code for the parameters selected. For example, if you type 3 as the Top N parameter, the three account codes with the highest rate code usage appear (see example Figure A-42 on page A-65). If you leave the Top N parameter blank, the account codes with the ten highest rate code usage appear.

Drill down: None

Parameters:

- Top N
- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Rate Code

Report Example

In this example, the rate code selected is MS Windows User CPU Time in Seconds.

Figure A-42  •  Top Accounts for Rate Report Example
Cost Trend Report

File name: RTRDC001

Stored Procedure: CIMSSP_Summary_Month

This report provides total charges by account code for each month of the year for the parameters selected. Monthly charges for each account code are presented on a single line.

**Note** • To print this report, use landscape mode on legal paper.

Drill down: None

Parameters:

- Account Code Level
- Report Year
- Starting and Ending Account Code

Report Example

![Cost Trend Report Example](image-url)

**Figure A-43 • Cost Trend Report Example**
**Cost Trend by Rate Report**

**File name:** RTRDC002

**Stored Procedure:** CIMSSP_Summary_Month

This report provides total charges by rate code description and rate group for each month of the year for the parameters selected.

**Note** • To print this report, use landscape mode on legal paper.

**Drill down:** None

**Parameters:**

- **Account Code Level**
- **Report Year**
- **Starting and Ending Account Code**

**Report Example**

![Cost Trend by Rate Report Example](image)

**Figure A-44 • Cost Trend by Rate Report Example**
Standard Reports

Resource Usage Trend Report

File name: RTRDR001

Stored Procedure: CIMSSP_Summary_Month

This report provides total resource usage by rate code for each month of the year for the parameters selected. This report is ordered by account code, rate group, and rate code.

Note • To print this report, use landscape mode on legal paper.

Drill down: None

Parameters:

■ Account Code Level
■ Report Year
■ Starting and Ending Account Code

Report Example

Figure A-45 • Resource Usage Trend Report Example
Transaction Report

File name: RTRNX001

Stored procedure: None

This report provides the Miscellaneous, Recurring and Credit, transactions for the parameters selected. For more information about transactions, see Chapter 5, Using Transactions.

Drill down: None

Parameters:
- Transaction Type
- Starting and Ending Account Code
- From and To Date

Report Example

![Transaction Report Example](image)

Figure A-46 • Transaction Report Example
Cost Variance Report

File name: RVARC001

Stored Procedure: CIMSSP_Variance

This report provides a comparison of charges by account code, rate code description, and rate group for a specified month and the month prior for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Report Month
- Report Year
- Starting and Ending Account Code

Report Example

![Cost Variance Report Example](image)

Figure A-47 • Cost Variance Report Example
Cost Variance Drill Down Report

File name: RVARC002

Stored Procedure: CIMSSP_Variance

This report provides a comparison of charges by rate code description and rate group for a specified month and the month prior for the parameters selected.

Drill down:
- Double-click a rate code description or its corresponding monthly totals, variance, or percent and a breakdown of data by account code appears.

Parameters:
- Account Code Level
- Report Year
- Report Month
- Starting and Ending Account Code

Report Example

Figure A-48 • Cost Variance Drill Down Report Example
Resource Variance Report

File name: RVARR001

Stored Procedure: CIMSSP_Variance

This report provides a comparison of resource usage by account code, rate group, and rate code description for a specified month and the month prior for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Report Year
- Report Month
- Starting and Ending Account Code

Report Example

![Image of Resource Variance Report Example]

Figure A-49 • Resource Variance Report Example
Disk Directory Resource Report

File name: RWDKR001

Stored Procedure: CIMSSP_Detail_Resource

This report provides windows disk storage data for the parameters selected. This data is taken from the CIMSDetail table.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-50 • Disk Directory Resource Report Example
Account Summary by Week Report

File name: RWEKC001

Stored Procedure: CIMSSP_Summary_Day

This report provides the total weekly and monthly charges by account code and rate code description for the parameters selected.

Drill down:
- Double-click the charge for a week and a breakdown of charges by rate code description appears.

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-51 • Account Summary by Week Report Example
Account Summary by Week—Wide Report

File name: RWEKC002

Stored Procedure: CIMSSP_Summary_Day

This report is similar to the Account Summary by Week report (see page A-74). However, the weeks are displayed across the top of the page.

Drill down:

- Double-click an account code and a weekly breakdown of charges by rate code description appears.

Parameters:

- Account Code Level
- Report Year
- Report Month
- Starting and Ending Account Code

Report Example

![Account Summary by Week—Wide Report Example](image-url)
Account Summary YTD Report

File name: RYTDC001

Stored Procedure: CIMSSP_Summary.Month

This report provides the total monthly and YTD charges by account code, rate group, and rate code description for the parameters selected.

Drill down:
- Double-click a month or the charge for a month and a breakdown of charges by rate group appears. Double-click a rate group and a breakdown of charges by rate code description appears.

Parameters:
- Account Code Level
- Report Year
- Starting and Ending Account Code

Report Example

Figure A-53 • Account Summary YTD Report Example
Account Summary YTD—Wide Report

File name: RYTDC002

Stored Procedure: CIMSSP_Summary_Month

This report is similar to the Account Summary YTD report (see page A-76). However, the months are displayed across the top of the page.

Drill down:

- Double-click an account code and a monthly breakdown of charges by rate code description appears.

Parameters:

- Account Code Level
- Report Year
- Starting and Ending Account Code

Report Example

Figure A-54 • Account Summary YTD—Wide Report Example
Spreadsheets

This section describes the ITUAM spreadsheets. When you run a spreadsheet, ITUAM Web Reporting presents the report data in Microsoft Excel. In addition to viewing the report in the Web browser, you can also save the spreadsheet as an Excel or other file or publish the report for all users. For more information, see Working With Spreadsheets on page 3-9. You must have Excel installed on the client running the spreadsheet.

Invoice Spreadsheet

File name: SINVC001

Stored Procedure: None

This spreadsheet provides invoice information for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Invoice Spreadsheet Example](image-url)

Figure A-55 • Invoice Spreadsheet Example
Run Total Invoice Spreadsheet

File name: SINVC002

Stored Procedure: None

This spreadsheet provides total invoice information by rate code for the parameters selected.

Drill down: None

Parameters:
- Starting and Ending Account Code
- From and To Date

Report Example

![Spreadsheet Image]

Figure A-56 • Run Total Invoice Spreadsheet Example
Standard Reports

Invoice by Rate Group Spreadsheet

File name: SINVC003

Stored Procedure: None

This spreadsheet provides invoice information for the rate codes within a selected rate group for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Rate Group

Report Example

![Spreadsheet Image]

Figure A-57  Invoice by Rate Group Spreadsheet Example
Invoice by Account Code Spreadsheet

File name: SINVC004

Stored Procedure: CIMSSP_Summary

This spreadsheet provides invoice information by account code for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-58 • Invoice by Account Code Spreadsheet Example
Proration by Total Amount Spreadsheet

File name: SPERX001

Stored Procedure: CIMSSP_Summary

This spreadsheet enables you to prorate an amount that you enter as a parameter across account codes. (The prorate amount can be greater or less than the actual charges.) The percentage prorated to each account is based on the total charge incurred by the account. That is, the higher the total charge for an account, the higher the percentage of the prorate amount that is assigned to that account.

Drill down: None

Parameters:

- Account Code Level
- Prorate
- Starting and Ending Account Code
- From and To Date

Report Example

In the following example, $700,000 is prorated across accounts for the parameters selected.

![Figure A-59 • Proration by Total Amount Spreadsheet Example](image-url)
Proration by Rate Code Spreadsheet

File name: SPERX002

Stored Procedure: CIMSSP_Summary_RateCode

This spreadsheet is similar to Proration by Total Amount report (see page A-83) except that the prorate amount is applied by account code to the rate code that you select.

Drill down: None

Parameters:
- Account Code Level
- Prorate
- Starting and Ending Account Code
- From and To Date
- Rate Code

Report Example

In the following example, $50,000 is prorated across accounts charged for the rate code WINCPUUS for the parameters selected.

![Proration by Rate Code Spreadsheet Example](image)

Figure A-60 • Proration by Rate Code Spreadsheet Example
Standard Reports

Proration by Rate Group Spreadsheet

File name: SPERX003

Stored Procedure: CIMSSP_Summary_RateGroup

This spreadsheet is similar to Proration by Total Amount report (see page A-83) except that the prorate amount is applied by account code to the rate group that you select.

Drill down: None

Parameters:

- Account Code Level
- Prorate
- Starting and Ending Account Code
- From and To Date
- Rate Group

Report Example

In the following example, $30,000 is prorated across accounts charged for rate codes belonging to the rate group MS Windows Processes for the parameters selected.

Figure A-61 • Proration by Rate Group Spreadsheet Example
Top 10 Accounts for Rate Spreadsheet

File name: STOPC004

Stored Procedure: CIMSSP_Summary_RateCode

This spreadsheet provides the account codes with the highest usage of a specified rate code for the parameters selected. For example, if you type 3 as the Top N parameter, the three account codes with the highest rate code usage appear (see example Figure A-62). If you leave the Top N parameter blank, the account codes with the ten highest rate code usage appear.

Drill down: None

Parameters:

- Top N
- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Rate Code

Report Example

In this example, the rate code selected is MS Windows User CPU Time in Seconds.

![Spreadsheet Top 10 Accounts for Rate Spreadsheet Example](image)

Figure A-62 • Top 10 Accounts for Rate Spreadsheet Example
Standard Reports

Account Summary Week Spreadsheet

File name: SWEKC001

Stored Procedure: None

This spreadsheet provides account summary weekly information by account code for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Report Year
- Report Month
- Starting and Ending Account Code

Report Example

![Account Summary Week Spreadsheet Example](image)

Figure A-63 • Account Summary Week Spreadsheet Example
Account Summary YTD Spreadsheet

File name: SYTDC001

Stored Procedure: None

This spreadsheet provides account summary YTD information by account code for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Report Year
- Starting and Ending Account Code

Report Example

This spreadsheet was run in March. The columns for the months April through December are empty and have been hidden so that the YTD column is visible.

Figure A-64 • Account Summary YTD Spreadsheet Example
**Account Summary YTD by Rate Spreadsheet**

File name: SYTDC002

Stored Procedure: None

This spreadsheet provides account summary YTD information by rate code description for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Report Year
- Starting and Ending Account Code

Report Example

This spreadsheet was run in March. The columns for the months April through December are empty and have been hidden so that the YTD column is visible.

![Account Summary YTD by Rate Spreadsheet Example](image-url)
Account Summary YTD Cost by Rate Group Spreadsheet

File name: SYTDC003

Stored Procedure. None

This spreadsheet provides account summary YTD information by rate code description for the rate group selected for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Report Year
- Starting and Ending Account Code
- Rate Group

Report Example

This spreadsheet was run in March. The columns for the months April through December are empty and have been hidden so that the YTD column is visible. The rate group selected is MS Windows Storage Charges.

Figure A-66  Account Summary YTD Cost by Rate Group Spreadsheet Example
Crosstab Reports

This section describes the ITUAM crosstab reports. Crosstab reports can be listed under the Reports menu, the Spreadsheets menu, or both depending on how your ITUAM administrator has set up your report groups. Crosstab reports run under Reports are in report format. Crosstab reports run under Spreadsheets are in spreadsheet format. The examples in this section show the report format.

Daily Crosstab—Charges

File name: XDAYC001

Stored procedure: CIMSSP_Summary_Day

This report provides total daily charges by account code and rate code description for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Daily Crosstab—Charges Report Example](image-url)
Daily Crosstab—Usage

File name: XDAYR001

Stored procedure: CIMSSP_Summary_Day

This report provides total daily resource usage by account code and rate code description for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Daily Crosstab—Usage Report Example](image)

Figure A-68 • Daily Crosstab—Usage Report Example
Detail by Identifier Crosstab

File name: XDETR001

Stored procedure: CIMSSP_Ident_Crosstab

This report provides total charges by rate code for a selected identifier value or values for the date range selected.

Drill down: None

Parameters:
- From and To Date
- Identifier
- Start and End Value

Report Example

In this example, the identifier selected is Process Name and the identifier start and end values are both svchost.exe.

Figure A-69 • Detail by Identifier Crosstab Report Example
Detail by Identifier by Date Crosstab

File name: XDETR002

Stored procedure: CIMSSP_Ident_Crosstab_StartDate

This crosstab report provides total and total daily charges by rate code for a selected identifier value or values for the date range selected.

Drill down: None

Parameters:
- From and To Date
- Identifier
- Start and End Value

Report Example

In this example, the identifier selected is Process Name and the identifier start and end values are both svchost.exe.

![Figure A-70 • Detail by Identifier by Date Crosstab Report Example](image-url)
Monthly Crosstab—Charges

File name: XMONC001

Stored procedure: CIMSSP_Summary_Day

This report provides total monthly charges by account code and rate code description for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Report Example Image]

Figure A-71 • Monthly Crosstab—Charges Report Example
Monthly Crosstab—Usage

File name: XMONR001

Stored procedure: CIMSSP_Summary_Day

This report provides total monthly resource usage by account code and rate code description for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Figure A-72 - Monthly Crosstab—Usage Report Example](image-url)
**Summary Crosstab—Charges**

**File name:** XSUMC001

**Stored procedure:** CIMSSP_Summary

This report provides total charges by account code and rate code description for the parameters selected.

**Drill down:** None

**Parameters:**
- Account Code Level
- Starting and Ending Account Code
- From and To Date

**Report Example**

![Image of the Summary Crosstab—Charges report example]

**Figure A-73  • Summary Crosstab—Charges Report Example**
Summary by Rate Group Crosstab—Charges

File name: XSUMC002

Stored procedure: CIMSSP_Summary_RateGroup

This report provides total charges by account code and rate code description for the rate codes within a selected rate group for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Rate Group

Report Example

In this example, the rate group selected is Unix Filesystem.

Figure A-74 • Summary by Rate Group Crosstab—Charges Report Example
Summary Crosstab—Usage

File name: XSUMR001

Stored procedure: CIMSSP_Summary

This report provides total resource usage by account code and rate code description for the parameters selected.

Drill down: None

Parameters:
- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

Figure A-75 • Summary Crosstab—Usage Report Example
Summary by Rate Group Crosstab—Usage

File name: XSUMR002

Stored procedure: CIMSSP_Summary_RateGroup

This report provides total resource usage by account code and rate code description for the rate codes within a selected rate group for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Rate Group

Report Example

In this example, the rate group selected is Unix Filesystem.

Figure A-76 • Summary by Rate Group Crosstab—Usage Report Example
Standard Reports

Weekly Crosstab—Charges

File name: XWEKC001

Stored procedure: CIMSSP_Summary_Day

This report provides total weekly charges by account code and rate code description for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date

Report Example

![Weekly Crosstab—Charges Report Example](image_url)

Figure A-77 • Weekly Crosstab—Charges Report Example
**Weekly Crosstab—Usage**

*File name:* XWEKR001

*Stored procedure:* CIMSSP_Summary_Day

This report provides total weekly resource usage by account code and rate code description for the parameters selected.

*Drill down:* None

*Parameters:*

- Account Code Level
- Starting and Ending Account Code
- From and To Date

*Report Example*

![Weekly Crosstab—Usage Report Example](image)

Figure A-78 • Weekly Crosstab—Usage Report Example
Templates

This section describes ITUAM report templates. These templates are launched when you create a report in ITUAM Web Reporting (see Creating and Running Web User Created Reports on page 2-9). Templates can be customized, but custom templates must be stored in the same directory as the standard templates. If ITUAM is installed in the default path, the location is C:\Program Files\IBM\ITUAM\Server\Reports\ Standard\Templates. Please consult IBM before you customize templates.

Report Both Template

File name: RTMPB001

Stored procedure: CIMSSP_Summary

This template produces Both reports that show resource usage and charges by account code and rate code description for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Four rate codes (selected when report was created)
- Four decimal place options (selected when report was created)
Report Examples

Figure A-79 shows the creation of a Both report called Storage Resource. Figure A-80 shows the resulting report that has been run from the Reports menu.

Figure A-79 • Creating a Report Example

Figure A-80 • Generated Report Example
The preceding examples are also applicable to the Cost and Resource reports with the following exceptions:

- The Report Type is Cost or Resource rather than Both.
- The resulting report shows resource usage or charges, not both.

**Report Cost Template**

**File name:** RTMPC001

**Stored procedure:** CIMSSP_Summary

This template produces Cost reports that show charges by account code and rate code description for the parameters selected.

**Drill down:** None

**Parameters:**

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Eight rate codes (selected when report was created)
- Eight decimal place options (selected when report was created)

**Report Example**

See page A-103.
Report Resource Template

File name: RTMPR001

Stored procedure: CIMSSP_Summary

This template produces Resource reports that show resource usage by account code and rate code description for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Eight rate codes (selected when report was created)
- Eight decimal place options (selected when report was created)

Report Example

See page A-103.

Spreadsheet Both Template

File name: STMPB001

Stored Procedure: None

This template produces Both spreadsheets that show resource usage and charges by account code and rate code description for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Four rate codes (selected when spreadsheet was created)
- Four decimal place options (selected when spreadsheet was created)
Report Example

Figure A-80 shows the creation of a Both spreadsheet called UNIX Process Image. Figure A-81 shows the resulting report that has been run from the Spreadsheets menu.
The preceding examples are also applicable to the Cost and Resource spreadsheets with the following exceptions:

- The Spreadsheet Type is Cost or Resource rather than Both.
- The resulting spreadsheet shows resource usage or charges, not both.

**Spreadsheets Cost Template**

**File name:** STMPC001

**Stored Procedure:** None

This template produces Cost reports that show charges by account and rate code description for the parameters selected.

**Drill down:** None

**Parameters:**

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Eight rate codes (selected when spreadsheet was created)
- Eight decimal place options (selected when spreadsheet was created)

**Report Example**

See page A-106.
**Spreadsheets Resource Template**

File name: STMPR001

Stored Procedure: None

This template produces Resource spreadsheets that show resource usage by account and rate code description for the parameters selected.

Drill down: None

Parameters:

- Account Code Level
- Starting and Ending Account Code
- From and To Date
- Eight rate codes (selected when spreadsheet was created)
- Eight decimal place options (selected when spreadsheet was created)

Report Example

See page A-106.
Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement might not apply to you.
This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX  78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurement may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.
Trademarks

IBM and Tivoli are trademarks of International Business Machines Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.
Glossary

**ASP** • Acronym for Active Server Pages. A server-side scripting environment developed by Microsoft for developing Web pages and applications.

**CSR File** • The resource file that contains the data that is input into ITUAM. The records in this file are comma-delimited and can contain a very large number of resource identifiers and resources. See also identifier and rate code.

**CSR+ File** • CSR+ files are similar to CSR files, with the exception that the records in the CSR+ file contain an additional header at the beginning of the record.

**cookie** • A small text file that stores information about a Web site user. ITUAM Web Reporting stores user information, such as the report parameter values entered by a user, in a cookie.

**identifier** • In the CSR or CSR+ record, a unique key that denotes the source of a resource that has been consumed. Examples include device name, server name, system ID, phone number, user ID, state code or building number. A consumed resource can have one to many identifiers.

**IIS** • Acronym for Internet Information Services. Microsoft software that supports Web site creation, configuration, and management.

**ODBC** • Acronym for Open Database Connectivity. An interface providing a common language for database access.

**rate code** • A rate code represents the resource units being reported (for example, CPU time, transactions processed or lines printed). The rate code includes the value for the resource and other rate processing information.

**stored procedure** • A set of SQL statements that can perform both queries and actions that allow the system to generate a report or reports.

**URL** • Acronym for Uniform Resource Locator. The address for a resource on the Internet or an intranet.

**XML** • Acronym for Extensible Markup Language. A meta-markup language that provides a format for describing structured data. XML allows for more precise declarations or content and more meaningful search results across multiple platforms.
Index

A
account codes
   explanation of 2-7
   selecting account code structure for reports 4-5
   setting levels that appear in starting and ending parameter lists 4-9
adding
   favorite reports 4-2
   transactions 5-3
auto logon, using 1-3

B
billing for miscellaneous, recurring, or credit items See transactions
browser
   Crystal Report viewer for, selecting
      for a user 4-6
      for all users 4-9
   resetting 4-7

C
configuring ITUAM Web Reporting
   system-wide configuration 4-8 to 4-10
   user-specific configuration 4-2 to 4-6
creating and running Web user reports 2-9 to 2-11
credits, applying See transactions
crosstab reports (standard), descriptions of A-90 to A-101
Crystal Reports
   use in ITUAM Web Reporting 1-2
   version XI
      troubleshooting 6-12
   viewer
      selecting for a user 4-6
      selecting for all users 4-9

D
deleting
   favorite reports 4-4
   published reports 2-17
   reports created by Web user 2-10
   transactions 5-4
drill down in reports
   closing 3-5
   example 3-6 to 3-7
   using 3-4 to 3-7

E
editing
   spreadsheets 3-10
   transactions 5-4
   e-mail address, setting 4-7

F
favorite reports
   about 4-2
   accessing 4-3 to 4-4
   adding 4-2
   deleting 4-4

H
Help, accessing 1-6

I
IIS, restarting 6-4
invoice number
   parameter setting 2-5
   system setting 4-8
ITUAM Financial Modeler, starting 4-11
ITUAM Web Console, starting 4-11
L
logging on to ITUAM Web Reporting 1-3 to 1-4
logging out of ITUAM Web Reporting 1-6

M
menu bar, using 1-5

N
navigating
  ITUAM Web Reporting 1-5
  reports 3-3, 3-4
  transactions 5-4

O
organization name and address, setting 4-8

P
parameters
  for reports 2-4 to 2-6
  for transactions 5-3
password
  about 1-5
  changing 1-5
  entering 1-3
paths for published reports, showing or hiding 4-5
printing
  reports 3-3
  spreadsheets 3-10
published reports
  creating 2-12 to 2-13
  deleting 2-17
  example 2-16
  filtering 2-15
  folder paths to, showing or hiding 4-5
  sorting 2-15
  viewing 2-14
  vs saved reports 2-12

R
Reporting Services
  troubleshooting 6-13
reports
  created by Web user 2-9
    deleting 2-10
    running 2-10
    updating 2-9
  drill down in 3-4 to 3-7
  example 3-6 to 3-7
  favorites
    about 4-2
    accessing 4-3 to 4-4
    adding 4-2
    deleting 4-4
  interface, description of 3-2
  navigating 3-3, 3-4
  parameters for 2-4 to 2-6
  printing 3-3
  published
    creating 2-12 to 2-13
    deleting 2-17
    example 2-16
    filtering 2-15
    folder paths to, showing or hiding 4-5
    sorting 2-15
    viewing 2-14
    vs saved reports 2-12
  running 2-3 to 2-4
  saving 3-3, 3-8
  standard
    about A-4
    descriptions of A-8 to A-108
    templates (standard), descriptions of A-102 to A-108
text
  copying text from 3-8
  searching for text in 3-4
types of 2-2

S
saving
  reports 3-3
  spreadsheets 3-10
security
  permissions required for folders 1-7
  user access to reports 2-13
spreadsheets
  closing in Excel 3-10
  created by Web user See reports, created by Web user
  editing 3-10
  favorites See reports, favorites
  interface, description of 3-9
  opening in Excel 3-10
  parameters for See reports, parameters for
  printing 3-10
published See published reports
running See reports, running
saving 3-10
standard, descriptions of A-78 to A-89
SQL Server Reporting Services, use in ITUAM Web
  Reporting 1-2
standard reports
  about A-4
  descriptions of A-8 to A-108
starting ITUAM Web Reporting 1-2

T
  templates (standard), descriptions of A-102 to A-108
  timing out
    about 1-6
    setting for 4-8
transactions
  about 5-2
  adding 5-3
  deleting 5-4
  editing 5-4
  navigating 5-4
  parameters for 5-3
  troubleshooting 6-2 to 6-13

U
  URL, entering 1-2
  user ID, entering 1-3